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1. CityGRID® Modeler Basics 

 

Note: The CityGRID® is available in three different variants: CityGRID® Inspector, CityGRID® Editor and 

CityGRID® Texture. This manual covers all three variants. For functions that require at least the Editor module 

are marked by the symbol . Functions that can only be run with the Texture module are marked by symbol 

. If no icon is present the function is available to all modules, (i.e. also Inspector) 

Modeler is a plug-in to Autodesk 3DS Max. If it is installed correctly, the menu CityGRID is available after starting 
MAX: 

 
The menu Start CityGRID Modeler Plug-in is only available after licensing the product (cf. 1.1). 

1.1. Start CityGRID Modeler 

Click on the CityGRID entry to start the Modeler Module. The GUI of Autodesk Max is extended by the CityGRID 
functionalities, the viewports are adapted and the selection window is opened (cf. 2.1). 

1.2. CityGRID® Tools 

You can find special tools here, which can be used outside the CityGRID® Modules. Currently you will find the BLOB 
Converting Manager (cf. 3.6.3), which can be used to convert 3D Studio objects (fountains, plaque columns, 
memorials, etc.) to CityGRID® data structure so that they can be managed like conventional CityGRID® buildings. 

1.3. Licensing 

The menu entry Start CityGRID Modeler and Start CityGRID Builder is available after licensing (cf. Manual 
CityGRID® Basics). 

If the Client successfully connects to the licence server activated module entries will appear under the menu point 
Licensing. CityGRID® is always licensed, even if the functionality of the manager is not included in the licence. 
CityGRID® Modeler and CityGRID® Builder can be licensed independently from each other. 

1.4. Setting Language 

Depending on which language is currently active, in the menu CityGRID the item Localisation, or 
Sprachunterstützung, etc. is available. Please select the preferred language for the user interface. 

1.5. Logging 

If an unexpected program execution or a program crash occurs, it can be useful to send the CityGRID® log file to 
UVM Systems GmbH. You can access this file quickly via the entry Open Log Folder. In certain instances it is 
possible that UVM Systems GmbH will request the comprehensive log file. To create such a log file use the menu 
entry Use Comprehensive Logging. Comprehensive Logging takes more time and should therefore only be 
used during consulting UVM Systems GmbH. 



 

  Manual CityGRID® Modeler – Page 8 

 

CityGRID
®

 

         MODELER 

1.6. The User Interface 

After starting the Modeler via the menu CityGRID > Start CityGRID Modeler Plug-in the user interface is adapted. 
The menu CityGRID is replaced by the menu CityGRIDModeler. A number of additional buttons appears and 
the Working Set Window (cf. 2.1) is opened. 

 

 

 

 

 
 

 

 

 

In the main window there are the central navigation mechanisms for the following tasks 

• Load buildings (units) in the required level of detail (LoD 1-3) 

• Display navigation of the 3D-window 

• Version administration 

• Coordinate offset of the used reference coordinate system 

 

        

Hierarchy Dialog  

Display of loaded 
region, in hierarchy 
tree form 

 

Layer Dialog 

Roof lines and roof faces 
separated by layers; select 
editing levels. 

 

Properties Dialog 

Information area, face  
generation type; extrusion 
types; single area coloring 

Top View 

 

Status bar  

Instructions may 
appear here 

Main Dialog 

Load Units; display of units; 
Version Management; 
Reference Coordinate System; 

 

CGModeler Menu  

Here, some general 
functions are 
available 

3D view  

(shows those elements which are 
activated in the visibility box, in this 
case polylines, roof faces and 
façades) 

 

Version Control  

Check out, Check in Units 

Display navigation 

of parts of the building (lines, 
faces), terrain, textures, 
selection polygons 

 

Data Source 

Load single Units or areas in a 
certain Level of Detail  

Reference Coordinate System 

Display of the applied offset 
values to keep coordinate 
accuracy 

Texture Dialog 

Texture images with 
projected geometry for 
interactive texturizing 
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The Command Panel of Autodesk 3D Studio Max is hidden, because only functions of the CityGRID® Plug-In are 
used for editing the geometry of building models. For example, CityGRID® locks all data that is not be editable as a 
result of on the current active settings.  

 

Note: If these locks are removed manually, the data integrity can’t be guaranteed any more. Geometry data 

may not be interpreted by CityGRID® correctly anymore and 3D Studio tends to become unstable. 

1.6.1. Assigning Hotkeys in Autodesk 3D Studio Max 

A number of actions of the CityGRID® Modeler can be started in addition to clicking at the respective buttons by 
user defined hotkeys. Assigning hotkeys is done by opening the dialog Customize > Hotkey Editor. Click on the 
first entry and then sort by ‘Category’. You then will see all Macro_v5_CGModeler functions, which can be assigned 
to a hotkey.  

Each of the following actions of the CityGRID® Modeler can be assigned a hot key. By clicking on  all 
assigned hotkeys and the current configuration of the 3D Studio user interface is stored. For example the position 
of toolbars can be individually defined this way. 

 

 

Note: Settings are saved in file CGModeler.kbdx. Find this file at the installation directory of 3D Studio Max 

in Folder “UI” of installed language package (e.g. D:\apps\Autodesk\3ds Max 2022\en-US\UI\ 

cgmodeler.kbdx) or in User Settings (e.g. C:\Users\whe\AppData\Local\Autodesk\3dsMax\2022 - 

64bit\DEU\de-DE\UI).  

 

Advice: Following Hotkeys are recommended for efficient modelling in CityGRID® Modeler: 

• Create auxiliary coordinate system from selection: defines local coordinate system 

• Select active complex from viewport: Allows for geometry picking in viewport. 

• Change distinguished mode: Assigns/removes distinguished mode from active complex 

• Triangulate 
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1.7. Description of buttons 

1.7.1. Standard mode 

Open Working Set Window Change database/XML file; Change Model/Street/Area  

Export Tool 

Toggle between Wire frame View and Shaded view switch on/off 

Close CityGRID 

1.7.2. Edit Mode  

Insert Point (in point selection mode), Create Line (in line selection mode) 

Create new Complexes (only in line selection mode) 

Coordinates Tool switch on/off 

Break Line Tool  

Line intersection Tool (insert intersecting points) 

Move point to face Tool (e.g. along a vertical line)  

Roof Protrusion Tool 

Transformation Tool 

Face Normals Tool 

Cut/Merge Tool 

Coordinate System Tool 

 

1.7.3. Texture Mode  

Back projection of lines of the active complex  

Create Material 

Copy Textures 

Delete all textures of the active complex 
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1.7.4. Terrain Mode 

Terrain Optimization Tool 

Terrain Clipping Tool 
 

1.7.5. Triangulate and Save 

 

Triangulate/Apply changes 

Save Unit  

 

Note: Clicking at the button Triangulate/Apply changes while holding the CTRL-Key pressed, 

triangulates only the active complex without triangulating connected complexes (cf. the advice about fast 

triangulation in section 3.1). 

Press the SHIFT key and click on the model level in Hierarch Dialog (cf 2.7) to force the triangulation of all 

model units. 

1.7.6. Menu bar in the texture window  

 
Cancel Action 

 Confirm Action 

 Restore Projection 

 Façade Tiling 

 Anchor Point mode 

 Display of Mesh 

 Zoom selection rectangle: wind-up zoom window with mouse. 

 Zoom: Move mouse up (out) or down (in) in order to zoom 

 Hide/Display Navigation Window  

 Pan zoomed region 

 Zoom to Extends 

 Scale back projected lines 

 Select and Move Anchor Points 

1.8. Coordinate System of the CityGRID® Modeler 

The 3D Models of the buildings can be generated in any cartesian coordinate system. It is not necessary to add 
reduction constants. CityGRID® manages coordinates with 7 digits before the comma without losing accuracy. The 
accuracy is generally restricted to 3 digits after the comma (mm). 

We recommend using an unreduced coordinate system for storing 3D building models. 

As Autodesk 3D Studio Max in current versions is not able to handle “large” coordinates with the necessary 
accuracy, CityGRID® moves the loaded coordinates automatically to a local coordinate system with reduced 
coordinates for editing. In general, the user need not care about it as long as he remains inside the CityGRID® 
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system. Although the coordinate display of Autodesk 3D Studio Max shows reduced coordinates, CityGRID® will 
always convert the coordinates back to global coordinates when saving them. 
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The reduction constants from the reference coordinate system to the local coordinate system are derived 
automatically when defining a working set (cf. 2.1.3) and are displayed on the graphical user interface. 

 
The automatic coordinate reduction determines the offset value at each new read model. This can lead to 
increased effort when reading external data (cf. 3.6.2), which shall be reduced by the offset value in advance. As 
an alternative to automatic coordinate reduction a manual shift can also be introduced. The Options menu (cf. 2.5) 
allows you to set a fixed offset that is used at model loading. 

 
Once the Use Custom RCS option is enabled, the Modeler will always apply the specified offset. The values 
entered are always those offset values that have to be added to the reduced coordinate system in order to get to 
the original system. In order to be able to quickly recognize the active mode for determining the offset value, there 
is an icon in addition to the figures that can have the following symbols. 

 
Automatic Offset 

 
User defined offset 

 

Note: The manual coordinate reduction should only be used if data is always loaded from same 

geographical area (e.g. city area). Due to implemented coordinate precision of 3D Studio Max, data up to 

a distance of 10000m can be handled with an accuracy of 1mm. Further increase of 10000 meters 

distance decreases accuracy by 1 mm. 

A wrongly configured Custom RCS can lead to irreversible damage to the data. The values should therefore 

be set only if necessary and well thought. 
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2. Working with CityGRID® Modeler 

The main task of the CityGRID® Modeler are editing of eave 
lines, dormer windows or building outlines, as well as 
modelling the roof surface and adding texture to the facades 
and roofs. In this section you will find explanations for these 
tasks step by step: 

2.1. Definition of the Working Set 
and the Data Source 

At the beginning you need to define the “Working Set” and 
data source. This is done in the „working set window“. 

2.1.1. Open/Change Database 
Connection 

1. Open working set window (cf. 1.7.1) 

2. Change to Database Mode: Choose Database in the 
selection Data Source 

3. Open Database Settings Window by clicking the 
button DB. 

4. Type in the name of the installed database service, 
the name of the schema of CityGRID®-tables in 
that database, the username and the password. Request these data from your database 
administrator.  

 

Note: For each database service one directory 

on a (network) drive must be declared as the 

path where textures are stored. This directory is 

an integral component of the data base service. 

Contents of this directory are administered by 

CityGRID® and must not be changed manually! 

 

Note: Valid database connection data are stored 

and can later simply be loaded in the saved 

services selection. By saving server- and 

database names/service multiple databases 

can be accessed quickly. When starting the 

Modeler always the last active data base 

connection is tried to be restored 

2.1.2. Open/Change Data File 

If the XML-Modeler is licensed, the data can be loaded from a file in the XML format specified by UVM Systems 
instead of a database: 

1. Open working set window (cf. 1.7.1) 

2. Change to XML Mode: Choose XML-File in the selection Data Source. 

3. Click button  to select XML file. 
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2.1.3. Definition of the Working Set 

For working efficiently Units can be grouped into Models. Switch from Terrain to Model in Selection by Terrain 
section to select a model from the database. 

 

Note: Typically, a Unit consists of all the buildings and building parts belonging to an address (e.g. main 

building + garages + sheds, etc.). Unit generation is the user's responsibility and is executed depending 

on demands and requirements. If no unit is generated, every closed eave polygon and the building edge 

lines within it forms a separate unit. 

Additionally Terrain models can also be accessed in working set window. To do so switch from Model to Terrain in 
Selection from Model section. All available terrain models will be listed immediately. 

A Model is a logical grouping of an arbitrary number of Units. One the other hand, a Unit can belong to an arbitrary 
number of Models. (cf. Manual CityGRID® Basics) 

The Working Set of a session can be defined by a Model (the recommended strategy), and/or by a UnitID or street 
name, and/or by a rectangular window and/or historic dates. This is done in the working set window. 

1. Selection by Model:  

Activate the checkbox Model and choose one of the models.  

2. Selection by Coordinates:  

Activate the checkbox Define Window and type in the lower left corner and the extents of the window. 
Use only Units, which lie completely in the region removes partially intersecting units from the selection 
area. 

3. Selection by Unit/Address: 

Activate the checkbox Unit and enter Unit criteria in Unit Selection windows Use pull down menu to switch 
between UnitID an Address 

o UnitID: 

searches the database for the given Name, which can be entered on the left side of the pull down 
menu. To load multiple Units enter any part of the UnitID (pay attention to upper and low case), 
wildcard for missing characters are not needed.  

 

Advice: Use Unit Selection to load single Units or Unit groups without loading a Model in these 

Units. It is highly recommended to allocate structured UnitIDs for sensible utilization of Unit 

Selection. 

o Street: 

loads all Units, which can be assigned to a street name. For restricting the selectable street 
names you can type in any part of the street name (case sensitive) in the line below.  

o House number: 

Use this field to narrow down street selections. Enlarge buffer creates a buffer around the 
selection from Street and House number and loads every unit that is (partly) inside this region. 

 

Note: The selection of a street is only possible in the database mode, if a link to an address 

database is installed. For installing such a link, please contact UVM Systems. 

 

Note: Requesting all UnitIDs in the database may take some time. So only select using UnitIDs when 

necessary.  

4. If you combine more the selections, the common set of Units will be loaded. 

 
Example: By selecting the Model “InnerCity” together with the Street “MainStreet” those buildings 

of the Main Street are added to the Working Set which lie in the inner city. 

 

Note: To load terrain models in CityGRID® XML schema without loading associated building models 

use XML files. Thus a visual check and interactive modelling of the terrain model in the Modeler is 

possible before starting building modelling or importing into the database. 
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By clicking the button  the working set window will be closed and the Selection Polygons of all Units in 
the Working Set are loaded. Afterwards the first Unit in the working set is loaded. 

2.2. Loading Single Units or Areas in a certain Level of Detail (LoD) 

After defining the working set (cf. 2.1.3) single Units or multiple Units of the working set can be loaded. 

If no special version of a Unit is loaded, the last stable version is loaded (cf. 2.6). 

 Load Previous Unit (in the order of the data source) 

 Load Next Unit (in the order of the data source) 

 Load single Unit graphically (by its Selection Polygon) 

 Load multiple Units graphically (by their Selection Polygons) 

 Load Units by attributes 

 Load a single Unit by its UnitID  

 Level of Detail of the loaded Unit(s) 

 

2.2.1. Load Previous/Next Unit 

By clicking at the buttons  one Unit after the other is loaded in the order in which they were imported into 
the database or in which they appear in the XML file, respectively. 

 

Advice: For better orientation the selection polygons can be activated in the display section of the main 

window. 

2.2.2. Select and Load a Single Unit Graphically 

By Clicking at the respective button  all Selection Polygons of the entire model are displayed in the drawing 
windows. If you click at one of these Selection Polygons with the left mouse button, this Unit is loaded immediately. 
With a right mouse click in the drawing window the selection mode can be cancelled. 

 

Advice: By pressing the CTRL-button when clicking the button, the zoom to extents function will be 

suppressed, thus making it easier to stick to the actual area of interest within the model area. 

2.2.3. Select and load multiple Units graphically 

By clicking at the respective button  the Selection Polygons are displayed in the drawing windows. If you click 
at one of these Selection Polygons with the left mouse button, this Unit is selected. Using the CTRL- and ALT Key 
when clicking at the Selection Polygons Units can be added or removed to/from the selection set. Furthermore a 
window can be dragged by the mouse in order to select several Units at once. 

 

Advice: By pressing the CTRL-button when clicking the button, the zoom to extents function will be 

suppressed, thus making it easier to stick to the actual area of interest within the model area. 

When the mode for selecting multiple Units is activated, two further buttons appear below the standard buttons: 

Load selected Units 

Cancel loading multiple Units 
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Once you are satisfied with your selection press one of the above buttons either to load your selection or to cancel 
the operation. 

2.2.4. Load a single Unit by its UnitID 

The UnitID is an Identifier which can be chosen by the User. It must be unique in a database/XML file. The ID may 
consist of letters and digits and is case sensitive, i.e. lower and upper case is crucial. 

When you type a UnitID into the respective field and confirm it with Enter (or by a mouse click), the Unit will be 
loaded. If no Unit with that ID exists in the working set, the ID of the last active Unit is displayed again. 

2.2.5. Load Units by attributes 

If certain attributes of Units or complexes of 
Units are known, these Units can be loaded 

specifically via the button  Load units 
via attributes. Th loaded Units are also 
highlighted in the hierarchy window. 

In the column Attributes the available 
attributes are listed, in the column Selection 
the respective values. 

By selecting the desired entries in the 
Selection column, the list of Units to be loaded 
is defined, which is transferred to the 

CityGRID® Modeler by clicking on  

If the selection is made on the basis of the 
object ID, the associated Unit in which the 
object with the selected object ID is located in, 
is loaded automatically. 

For simplified search, a filter field is available 
in which an independent search filter can be specified for each attribute listed. If you switch between the attributes, 
the entered search filter is retained. Every entry in the filter field must be confirmed with the enter key. 

 

Advice: To pass multiple filter values to the system, enclosed them in double quotes (") (for example" 123 

"" 345 ") 

 

Advice: If no selection in the selection column is made for a set filter, CityGRID® Modeler interprets this as 

a complete selection and loads all listed entries. 

2.2.6. Level of Detail of the Loaded Unit(s) 

Units are stored in several Levels of Detail (LoD) can be loaded in any of these levels (only in database mode). 

The following LoDs are implemented: 

0 … Plan 

1 … Block Model 

2 … Form Model (with roof shape and ev. roof protrusion) 

3 … Detailed Model (including dormer windows, etc.) 

The models of a Unit in lower LoDs are derived automatically from the higher LoD. For the Box Model, a planar eave 
line is used in an average elevation. This elevation can also be defined by the user (cf. LoD1 elevation in section 
2.8.4). 



 

  Manual CityGRID® Modeler – Page 18 

 

CityGRID
®

 

         MODELER 

 

Note: Checkout and Editing is only possible, if the Unit is loaded in the highest LoD 

2.2.7. Notes for the Graphical Selection 

The Selection Polygons are drawn in different colours depending on the state of the last valid version of the Unit 
(cf. 2.6). If the default colour scheme had not been customized, the colours indicate different states of units: 

• Light gray:  

The last valid version is a stable, non-torn-down version. 

• Red:  

The last valid version was checked out in another session of Autodesk VIZ or MAX (presumably another 
operator works with it). If this unit is loaded, the latest, stable version is loaded by default. In the options 
window this procedure can be modified. 

• Green: 

The last valid version was checked out in the current session of Autodesk VIZ or MAX. If you load that Unit, 
the checked-out version will be loaded. 

• Dark gray:  

The Unit was torn down in its last valid version. 

 

Advice: If you press the CTRL-Key while clicking at the buttons for select and load single/multiple Unit(s), the 

zoom factor is preserved in the top and front drawing window when the Selection Polygons are drawn. This 

can help keeping the orientation in complex situations. 
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2.3. Optimizing the Display Driver in Autodesk 3D Studio Max 

 
To be able to display 3D content, 3D Studio Max must use a suitable 3D driver. Currently there are three different 
drivers, Direct3D, OpenGL and Nitrous, available in different versions. By default, 3D Studio Max uses the Nitrous 
driver, which is a proprietary development from Autodesk. To see the best results when working with the CityGRID® 
odeler, it is recommended to use the Nitrous -DirectX driver in its most recent version. 

To change the display driver, go to the main menu of the 3D studio and select the menu item Customize> 
Preferences, on the Viewports tab, in the Display Drivers group. The button Choose Driver will take you to the 
selection list of available display drivers. After changing a driver the 3D Studio has to be restarted to make the 
changes effective. 

2.4. Customizing the Views 

2.4.1. Customizing the 3D View 

The CityGRID® Modeler works with a central projection in the 3D window, which can be turned, moved and zoomed 
with the navigation possibilities of Autodesk 3dStudio Max. 

These are: 

• Pan: press mouse wheel and move mouse 

• Turn: ATL Key + mouse wheel pressed and move mouse 

• Zoom: ALTGR Key + mouse wheel pressed and move mouse forward/backward. 
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Note: When changing the active complex it will be zoomed on the extension of the newly chosen complexes 

if the option “activate automatic zoom” is selected in the right-click menu of the layer window. 

2.4.2. Changing the Visibility 

The visibility can be changed for all loaded Units simultaneously. In the View box the visibility can be switched on 
and off for the following groups: 

• Lines 

• Faces (they are only after triangulation available)  

• Terrain: In general, only the needed part of the terrain model is displayed.  

• Textures: All available textures will be loaded (roof, facade and terrain) 

• Selection Polygons: The Selection Polygons of neighbouring (not-loaded) Units of the 
Working Set are displayed, too. This may be useful for better orientation. 

Active views are indicated by a colored background. The views set remain valid for the duration of the active session 
and only change with one click of the user. Restarting the Modeler restores the default settings. 

 

Note: Additionally, in the “Element Properties Window” you can change the visibility of single line layers and 

Element-Faces. In the Options window you can also choose that the entire terrain shall be displayed. 

2.4.3. Display of inactive Complexes 

For editing it is always necessary to activate a building complex. This complex is called the Active Complex (cf. 
2.7). All other building complexes are inactive. Inactive building complexes can be displayed   

• coloured, fully visible, 

• gray, transparent, 

• invisible. 

Changing the appearance of inactive complexes is done in the right-click-menu of the Hierarchy Dialog (cf. 2.7.1). 
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Under the menu View representation of inactive geometrical objects the appearance of 

• inactive Units 

• inactive complexes (other Objects, Element Complexes)  

of the active Unit can be changed. 

 

Note: For opening this menu without changing the Active Complex, you need to click into the lower free space 

or the border of the Hierarchy Dialog. 

2.4.4. Changing the Colour scheme (User Defined Default Colours) 

The default colours for line and face layers may be customized individually for each user. This will be described in 
this section. 

Further, face layers of single Elements may be assigned specific standard materials. These are stored with the 
Element and will override user defined standard colours (cf. 2.8.4). 

The user defined default colours of line and face layers of Units can be changed by opening the menu CGModeler 
> Edit User Defined Default Colour. A dialog is opened for setting the layer colours individually for each Object 
class and Element class.  

The first layers in the layer selection field are those line layers that exist for the respective Object class and Element 
class. The last layer is the respective face layer. 

The colour selection dialog can be opened by double-click at the respective layer name or by clicking at the colour 
field. 

The same way colours of terrain faces, Selection Polygons and other as well as the background colour and the 
colours of the selection and sub-selection can be specified. 

2.4.5. Toggle between Wire Frame View and Shaded View 

For that purpose a button  in the row of standard buttons is available (cf. 1.7.1). 

2.5. Options menu 

The Options menu can be accessed via menu CGModeler > Options. Here 
are found the universal parameters for calibrating CityGRID® Modeler. 

Texture 

• The Line Width defines the size of the re-projected projected lines in 
the texture module 

• The Resolution of the texture controls the image quality while 
working with Autodesk MAX (View) as well as the Export. The 
numeric value defines the pixel ratio in mm to reality. E.g. a value of 
100 means, that a pixel equals 100 mm. 

Triangulation: 

• Mode for preserving Texture controls the triangulation behaviour 
of already textured surfaces. 

o Only unchanged faces checks if topology of the textured 
surface would change during triangulation. This happens in 
particular when points are added in the line framework and 
therefore the surface formation changes. Areas with a new 
surface configuration lose the existing texture during 
triangulation while unmodified areas retain them. 
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Example:

 

The left building shows the original state, the façade upper edge with three vertices and the 

resulting face framework according to this. In the middle image an additional edge is added to 

the façade upper edge. The right image shows the result of the Triangulation. The right part of 

the façade is identical with the original state and therefore the applied texture is retained. The 

surface configuration of left section of the façade however differs from the original state and 

therefore no texture is retained for this section. 

o All Faces analyses the object which has to be textured in several ways before assigning textures. 
First all faces are overlayed with textures if they have textures assigned. Then faces are 
determined from the remaining which have images applied and a texture can be assigned with a 
projection. 

• Mode for inheriting Texture to Children determines the conditions under which textures of a parent 
element are passed on to the child element complexes. 

o Always textures all surfaces of a child element complex from the textures of the parent element. 

o Only to Elements of corresponding Element Class ensures that texture transfer occurs only for 
certain element classes. Roof texture is inherited to element classes, roof, ceiling and combined, 
facade texture to façade and vertical roof face. 

o Never generally prevents texture inheritance. 

• Max. Angle preserving Texture (°) is used for this determination. It controls how much the surface 
normal of potential textureable faces can differ from the original surface normal, for which these 
textures were determined. 

 

Note: The maximum value for the tolerance angle is 90°, which means that all faces which lie up 

to 90° opposite the actual textured face are automatically assigned the same texture.  

If faces are detected which are within this threshold and don’t have a texture, the dimension of the 
textures, which shall be assigned, are ascertained to fit the faces. If all these parameters are fulfilled 
the texturing of the faces happens automatically. 

 

Note: For check-up the coverage of the faces with texture images use CGModeler > Auxiliary Objects 

> Show auxiliary data of the texture image to display a schematic view of the textures with their 

dimension and their surface normal.  

 

Advice: The interactive allocation of roof texture images (cf.8.1) of LoD3 buildings in Preserve 

texture at triangulate Mode causes all roofs with detail element complex to get the roof texture from 

the main roof automatically unless the detail element complexes don’t overhang the main roof too 

much. 

In general the setting all faces has the effect that already applied textures, façade textures in 
particular, are preserved during triangulation. 
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Example: 

 

The left house shows the original state, the façade upper edge exhibits the left and the right vertex 

as edge and according to this the face framework is built. 

In the middle picture the façade upper edge has had a bay added, so that the façade has a clear 

different form compared to the original state. The threshold for tolerance angle is 30°. In this case 

the part of the bay where the surface normal is identical with the original picture gets the same 

texture automatically. The inclined faces of the bay, displayed with red arrows in the schematic view,  

don’t get textures since the contortion of the surface normal compared to the original state is greater 

than 30°. 

The right picture shows the result of setting threshold for tolerance angel to 60°. In this scenario the 

inclined faces are textureized because the surface normals have less than 60° contortion and the 

façade segment was covered by the original texture image. 

• Threshold for Detail Binding. Defines the maximum distance between the vertices of the eave polygon for 
Detail Element Complexes and the element faces of their parent elements, up to which the conversion of 
the line framework is triggered in the binding of the Detail Element Complex (cf. 5.4). 

 

Note: The larger the value you select here, the more inaccurately can Detail Element Complexes 

be modeled to parent faces in the intersection area. At the same time there is an increased risk 

that fine modeling features may be lost in the binding process With Roof Detail Element 

Complexes in particular, there is the risk that small side faces may be lost and the roof face 

merges with the surrounding elements.  Depending on the modeling situation, the value may have 

to be adapted. 

Settings 

• Double-sided displays all surfaces in Viewport in and towards the surface normal direction. Thereby 
surfaces are viewable from both sides. If this option is not activated, surfaces can only be seen if you 
look towards their surface normal direction. 

• VP error (Viewport error, activation recommended): If activated, continuous redraws are made, but 
could be dispensable with a powerful graphic card. 

• Terrain aperture: Defines if the whole terrain or only an aperture should be loaded and displayed. 

 

Note: The view of whole terrain models can lead to massive performance loss! The required 

computing time for Check-Out, Save, Triangulation and Check-In the in particular depends on if the 

whole terrain model or only an aperture is used! 

• Load checked out Version: If activated, always the last version is loaded, independent if this version is 
checked-in or checked-out. 

 
Advice: This option is only active, while a single Modeler is working on a single model, which prevents 

mutual overwriting! 
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• Threshold for face polygon is the distance of adjacent surfaces normals with length of one meter (unit 
vector). For small angle values it corresponds with the angle between the surface normal in radian 
measure. 

 
Example: A value of 0,01 corresponds with an aberration of 1cm of a one meter long 

surface normal and respectively an angel of 0,01 π. Converted to degree the value 

would be 1,8°. 

Defines when aberrations of adjacent surfaces can be seen as planar and grouped as selection. This 
parameter has impact on the (red) knuckle lines in Viewport, which are indicators for forced edges 
while triangulation and are hints on bends inside a polygon. In the same way it controls which surface 
should be automatically selected if polygon selection is used in the texture mode (c.f. 8.1). 

• Clipped Terrain enlargement: Defines how far the applied clipped terrain is extended beyond the 
derived minimal required area. The minimal area is defined by an intersection of each units bounding 
box with all terrain triangles. Every hit terrain face is used for clipped terrain. 

 
• Database access ordered by defines how lists for models, buildings and images are sorted. 

Alphabetical or creation date, both ascending and descending is available. 

• Use Custom RCS defines the offset value that is applied at loading of models into CityGRID® Modeler 
(cf. 1.8). The figures indicate the offset from the reduced coordinate system to output system. 

2.6. Version Management   

The version management is accessible in the database version of the CityGRID® Modeler and ensures that older 
versions cannot get lost, but can be loaded again (cf. manual CityGRID® Basics). The version management can be 
used on the one hand for saving the editing history and on the other hand for making comprehensible the building 
history of a Unit or a DTM. With each version the check out/check in date as well as a comment is stored. 

A version can have one of four states: 

• “-“ (none):  

For stable versions no special state is stored (except for state “torn down“). 

• “Checked out“:  

This version is checked out for editing. Only the last version can be checked out. For a checked-out 
version, there exists always an older stable version.  

• “Disabled“:  

Invalid versions may be locked. (Units only) 

• “Torn down“:  

For Units which have been demolished, a torn-down version is stored as last stable version. This ensures 
that the Unit exists with its version history so that historical states can be accessed. (Units only) 

If not a special version is loaded, the last stable version is loaded (condition 1 or 4) or a checked-out version, if it 
was checked out in the current session of Autodesk 3D Studio Max. 
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A unit, of which the last valid version is a checked-out version but which was not checked out in the current session 
of Autodesk 3D Studio Max, is: 

• either currently edited by another operator 

• or was checked out in an earlier session of Autodesk 3D Studio Max. 

The operator must verify which of the two cases is true and can then – if appropriate – load the checked out version 
explicitly (cf. 2.6.4). 

You can also change the version class of each version in Version Management. Versions may assume the states of 
"Working Version" or "Historic Version". 

 

 

Note: The version control for aerial images can’t be accessed at the user interface of CityGRID® Modeler, 

as changes there don’t require interactive work and can therefore be done globally in CityGRID® 

Administrator. Loaded Models always refer to the latest versions for aerial images, old versions can be 

deleted from database via CityGRID® Administrator if needed. 

2.6.1. Checking Out a Unit   

1. Load the Unit in the highest LoD and activate it (cf. 2.2 and 2.7).  

2. Click at Check-Out active data set.  (cf. 2.6.1) 

3. You may provide a comment (such as “Roof correction”, “Texturing façade”, “Update 2005”, etc.) 

4. Click at . 

5. The Unit will be checked out. A new version of the Unit is created in the database. This version is released 
for editing. When editing the Unit you can store the Unit any time which means that this version is 
overwritten each time. However, earlier versions are not changed. 

 

Note: If the CTRL key is pressed while clicking at Check-Out active Unit, points 3 and 4 are suppressed. 

2.6.2. Checking Out a DTM   

1. In Working set window switch from Model to Terrain in Selection from Model Section (cf. 2.1.3)  

2. Select the desired terrain model and press  

3. Activate Terrain model in hierarchy window. (cf. 2.7) 

4. Click at Check-Out active data set.  (cf. 2.6.1)  

5. You may provide a comment (such as “Terrain correction”, “Update 2019”, etc.) 

6. Click at . 

7. The DTM will be checked out and a new version is created in the database. This version is released for 
editing. When editing the DTM you can store at any time which means that this version is overwritten each 
time. However, earlier versions are not changed. 

 

Note: If the CTRL key is pressed while clicking at Check-Out active Complex, points5 and 6 are suppressed. 
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2.6.3. Checking In a Unit/DTM with Saving   

1. Activate the Unit (cf. 2.7). 

2. Click at Check-In active data set  (cf. 2.6.2) 

3. Confirm the text or overwrite it. 

4. Click at . 

5. The Unit will be stored and the state of the version will be reset to “None”. 

 

Note: If the CTRL-key is pressed while clicking at Check-In active Unit with Saving, points 3 and 4 are 

suppressed. 

 

Note: Save with Checkin is a function designed for use at geometry modelling. At interactive texturing Save 

before checkin is required to store work done in database. 

2.6.4. Load a specific Unit Version explicitly   

For loading a specific version of a Unit, first the default version of the Unit must be loaded and activated. Afterwards 
the “Version History Window” can be opened and the desired version can be loaded:   

1. Load the Unit and activate it (cf. 2.2 and 2.7). 

2. Open the Version History Window   

3. Select the desired version (by clicking at Details the comment and the date of the version can be viewed) 

4. Click at  for loading the version 

 

Note: Disabled versions cannot be loaded. 

 

Note: Only checked out versions can be loaded with terrain models, loading of any arbitrary version is not 

yet implemented. 

2.6.5. Rejecting a Checked-out Version   

1. Activate the Unit (cf. 2.7). 

2. Click at Rejecting a Checked-out Version . The checked-out version will be deleted 
and the last stable version will be loaded. 

2.6.6. Version History Dialog 

All actions previously described with Unit versions are recorded in the Version History. Every stable version is listed 
in the Version History Dialog, starting with the first version of a Unit, which is typically created on import to the 
database, through to the latest version. 

Each version is assigned a unique number and various attributes. The affected version is activated by selecting a 
line and released for operations. Load loads the activated version to Modeler (cf. 2.6.4); Enable and Disable 
render a version inaccessible or re-accessible (cf. 2.6.6); and Details opens the Properties Dialog for each 
version. 
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2.6.7. Mark a Unit Version as Disabled   

A checked-out version can be deleted by Rejecting a Checked-out 

Version . Other versions cannot be deleted but only marked as 
disabled.  

1. Load the Unit and activate it (cf. 2.2 and 2.7). 

2. Open the Version History Window  

3. If necessary, load another version (not the one which is to be 
disabled) (cf. 2.6.4) 

4. Select the desired version 

5. Click at  for marking it as disabled. 

 

Note: A version can only be disabled, if another version is loaded. 

In a similar way, a version can be enabled again (button “Enable”). 

2.6.8. Edit a Unit starting from an old state   

Checking out is only possible, if the last stable version of a Unit is loaded in the highest LoD and if there exists no 
checked-out version. 

If you want to edit a Unit starting from a historic state, first you’ll have to mark all younger versions as disabled (cf. 
2.6.6). Then, you can check out (cf. 2.6.1). 

2.6.9. Converting Working versions into Historic versions 

Every checked-in version is a working version by definition. This version class is typically used to model a building 
in order to save intermediate steps (e.g. main roof modeled, roof landscape ready, texturizing, etc.). In order to 
implement a time series of the building state in the database, not all of these versions are necessary. Normally, 
only versions are needed which represent the finished building model, or the state of the building at a specific point 
in time. To meet this requirement, CityGRID® offers you the option to convert a working version to a historic version 
(see CityGRID® Basics Manual). 

1. Load and Activate Unit (cf. 2.2 and 2.6.9) 

2. Click on Open Version History . 

3. Select a working version (stable version).  

4. Open Version Details by clicking on . 

5.  Class: change from Working Version toHistoric Version. 

6. Enter a Creation Date and Termination Date as required.  

 

Note: If you prefer not to specify a date, CityGRID® interprets this 

as "the building already exists" or "the building will stand for ever". 

Otherwise, define a validity period for the specified version. 

7. You can enter a descriptive text for the version under Comments. 

8. Click on  to confirm the conversion. 

After this procedure, the Version History Dialog displays the entry Historic Version in column Class for the active 
version. 

Once a Historic Version exists, a menu is activated at bottom left, permitting you to restrict the view of the Version 
History Dialog to historic versions. If you change from Check All Versions to Historic Versions, only Historic 
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Versions are displayed, and the Creation Dates and Termination Dates are checked whether their chronological 
sequence is correct. If the chronological sequence is incorrect, the Historic Versions are highlighted in green font. 

2.7. Active Complex, active Element, active Data set 

The hierarchy of building complexes is used in CityGRID® is explained in Manual CityGRID® Basics. The overall term 
for Unit, Object, Main Element Complex and Detail Element Complex shall be in the following “Complex”. 

Only one building complex can be selected as the “Active Complex”. 

Editing actions are possible only in the Active Complex. Depending on the hierarchy level of the Active Complex 
(Model, Unit, Object, Main Element Complex, Detail Element Complex), some editing actions are permitted or 
prohibited. 

Units and Terrain models are referred to as active data sets. 

2.7.1. Hierarchy Dialog of loaded Units 

Only a loaded Unit or a part of it can be set as Active Complex. The 
loaded Units are shown with their hierarchy as tree in the “Hierarchy 
Dialog of loaded Units”. The Active Complex is highlighted in blue. 

In this window, the Units are sorted by their UnitIDs. 

The order of Objects in a Unit is arbitrary and may change after editing 
actions. The same is true for the order of Main Element Complexes in 
an Object and for the order of Detail Element Complexes in a Main 
Element Complex. 

 

Advice: The hierarchy window is a freely positionable control of the CityGRID® Modeler. After starting, the 

hierarchy window is positioned at a predefined position. Each user can further adapt the position of this 

window and also adjust the size. To do this, place the mouse pointer on the edges of the control and then 

drag the window in the desired direction. The corners can be used to change the size in length and width 

at the same time. 
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2.7.2. Selecting the Active Complex 

Selecting the Active Complex can be 
done by 

• selecting a complex in the 
tree of loaded Units in the 
Hierarchy Dialog 

• selecting a complex 
graphically after activating 
the mode pick complex in 
viewport in the right click 
context menu in the 
hierarchy dialog.  

 

Advice: This function can 

be very helpful for quickly 

jumping to another active 

complex. I 

After selecting a new complex, the 
Modeler automatically zooms to the 
extents of that complex, if the option 
activate auto zoom is selected in the 
right-click menu of the Hierarchy Dialog. 

2.7.3. Highlighting 
Active Complexes (Search For Attributes) 

In order to mark loaded complexes in the Hierarchy Dialog, e.g. to find them more easily later, the program provides 
a highlighting method. You can use this method to assign a Highlighted status to any complex, with the exception 
of the model vertex. 

Highlight a complex by 

• setting the interactive entry Highlighted in the Hierarchy Dialog context menu, which you open by right-
clicking on a complex. 

• defining attributive search parameters in the loaded complexes in the dialog Highlight By 

Attributes . 

Proceed as follows to highlight complexes by attributes: 

1. Load the object you require by selecting Select Multiple Unit  or Load Unit By 

Attributes . 

2. Click on Highlight By Attributes . 

3. Then select the required attributes in the pop-up dialog. 

List the existing attributes for your search in the Attributes column. The Selection column displays the 
existing values in the loaded dataset for the attribute you select.  

Define the list of highlighted complexes by selecting the required entries in the Selection column. Click on 

 to transfer them to CityGRID® Modeler. 

A filter field is provided to simplify your search. Specify a separate search filter for each of the listed 
attributes. The specified search filter remains active when you switch between attributes. Confirm each 
entry in the filter field by pressing the Enter key.  
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Tip: To transfer several filter values to the system, write them in double quotes (") (e.g. "123" "345"). 

 

Tip: If you make no selection for a set filter in the Selection column, CityGRID® Modeler interprets this as 

Select All and loads all the listed entries. 

The buttons Previous highlighted complex  and Next highlighted complex  
are provided in the Hierarchy Dialog to navigate through highlighted complexes. Click on one of the buttons 
in the Hierarchy Dialog to change the active complex automatically. 

The complexes remain highlighted until a new model is loaded from the data source, or the dialog is re-
opened. In this way, any area within a model can be regenerated (cf. 2.2) without losing the highlighted 
status on each of the complexes. 

Right-click on a highlighted complex in the Hierarchy Dialog to remove the marking by deselecting the 
Highlighted entry in the context menu. 

 

Note: To globally cancel all highlights on all Units in the model, hold down the CTRL key and click on 

Highlight By Attributes . 

2.7.4. Actions with highlighted Complexes 

You can perform various actions on highlighted complex and then process them one by one, Unit by Unit. The 
available actions always assume a synchronous action which is applicable to each Unit. All actions for highlighted 
complexes are located in the context menu under the option All Highlighted Complexes in the Hierarchy Dialog. 
Right-click a highlighted complex to open the context menu. The list of actions currently available in the context 
menu include: 

• Check-out (cf. 2.6.1) 

• Check-in (cf. 0) 

• Undo Check-out (cf. 2.6.5) 
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Note: You can only use the Check-in and Check-out functions in conjunction with a database. These options 

are not available for XML files. For databases, at least the selected action must be executable for a 

highlighted Unit.  

• Attribute-Table (cf.7.1) 

• Face manipulation options (cf. 5.9) 

• Generate Faces (Triangulate) (cf. 1.7.5) 

• Delete (cf. 5.6) 

 

Note: Deleting highlighted complexes takes into account the validity of the remaining complexes. That is to 

say, when the higher-level complex is emptied by a delete operation (cf. CityGRID® Basics Manual), the 

complex is removed automatically. If you need to remove an entire Unit as a result, the Unit is set to the 

status Torn Down in the database (cf. 5.6). In XML files, the Unit is deleted. 

• Remove Highlighted Status (for all highlighted complexes) 

Besides the actions in the context menu, you can also use drag & drop actions with highlighted complexes (cf. 5.8). 
To execute drag & drop actions successfully, the following rules apply: 

• Only deal with complexes with the same Hierarchy level (e.g. Units, Objects, Element Complexes, etc.). 
If different complexes were highlighted, only the clicked complex is dragged, but not all the other 
highlighted complexes. Here, it does not matter whether there are other highlighted complexes of the 
same hierarchy level among the highlighted complexes, or not. In this case, a warning appears in the 
Warning Dialog (cf. 2.10). 

• As soon as you start a drag & drop action for several highlighted complexes, a dialog appears to define the 
complexes to which the action is applied "Yes" drags all highlighted complexes. "No" drags the clicked 
complex. "Cancel" ends the drag & drop function without dragging the complexes. 

• If you start a drag & drop function for checked-in complexes in the database, the complexes are not 
addressed and a corresponding warning appears in the Warning Dialog (cf. 2.10). 

2.8. Properties of the Active Complex 

The Properties Window of the Active Complex is docked on the Hierarchy Dialog of loaded Units, if the option show 
properties dialog is checked in the right-click-menu of the Hierarchy Dialog. 

 

Note: For opening this menu without changing the Active Complex, you need to click into the lower free space 

or the border of the Hierarchy Dialog. 

Depending on the hierarchy level of the Active Complex the Properties Window has different appearance. 
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2.8.1. Model Properties 

If the Model the loaded Units belong to is activated in the Hierarchy Dialog as 
the Active Complex, the Model Properties window is shown in case the option 
“show properties dialog” is selected in the right-click-menu of the Hierarchy 
Dialog. Here, the Name of the Model is shown. 

• The ModelKP indicates the unique database key of the Model (this 
value is null for XML data sources).  

• The value in the field Units gives the number of Units belonging to 
the Model. These two values cannot be edited. 

• The button Model Administration  can be used for 
adding/removing Units from the Model and creation of new 
models (cf. 6.1.5). 

• In the group Data References the terrain models which are 
assigned to the Model is shown. Furthermore the names of the 
texture images are given. Define for each texture image if it should 
be used as area – or roof texture image or for both. 

 

Note: The terrain texture is always derived online when requested whereas the texture of Units must be 

precalculated (cf. 7). 

2.8.2. Unit/Version Properties 

If a Unit is activated in the Hierarchy Dialog as the Active Complex, the Unit Properties window is shown in case 
the option show properties dialog is selected in the right-click-menu of the Hierarchy Dialog. 

Non-Editable Fields (Status Information of Unit properties):  

• The field Objects shows the number of Objects in the Unit. 

• The UnitKP indicates the unique database key of the Unit (this value is null for XML data sources). 

• Address: If a link to an address database is installed in the database, the address of a Unit can be 
shown. For that purpose, the checkbox right to the address field must be checked. Per default it is not 
checked as each address query needs some (short) time. 

Editable Fields (Unit properties): 

• The UnitID is an alphanumerical (may consist of letters and digits), unique identifier for the Unit which 
can be chosen by the operator. 

• The name of the Unit can be given.  
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• A detailed description can be given. This description is used when 
publishing for the internet.  

 

Advice: Use CTRL-Return in order to insert a new line. 

• A web link can be assigned to the Unit. 

Non-Editable Fields (Status Information of Unitversion properties): 

• Number: Defines the version number of the loaded Unit version. 

• Checked-out indicates whether the Unit is a stable version, or 
whether it is checked out for editing. 

Editable Fields (Unit version properties): 

• Class indicates the present version class. In the dropdown menu, you 
can change the version class of stable versions at any time (cf. 2.6). 

• Creation Date: Defines the start of the version validity period. If no 
value is entered, CityGRID® interprets this as "the building has always 
existed". 

• Termination Date: Defines the end of the version validity period. If no 
value is entered, CityGRID® interprets this as "the building will stand 
for ever". 

 

Note: Creation and Termination Dates can be set for every Unit version. However, they are only evaluated 

for Historic Versions. Nonetheless, it may be practical to fill in the values for working versions so that the 

individual Creation and Termination Dates exist for later class changes. 

By clicking at the button Save Changes the new data are taken over and immediately written to the database/data 
source. 

 

Note: These metadata of a Unit are the same for all versions of the Unit. 

 

Tip: If only the Class or the Creation and Destination Dates need to be changed for a version, it is much faster 

to execute the action in the Version Details Dialog (cf. 2.6.9), since the save process takes much less time 

there. 

2.8.3. Object Properties 

If an Object is activated in the Hierarchy Dialog as the Active Complex, the 
Object Properties window is shown in case the option show properties dialog 
is selected in the right-click-menu of the Hierarchy Dialog. 

• Complexes: 

shows the number of Element Complexes in the Object. 

• ObjectKP: 

Indicates the unique database key of the Object, the ObjectID a 
consecutive number of the Object used by the XML-Modeler. 

• ObjectID: 

is an alphanumerical (may consist of letters and digits), unique identifier for the Object which can be 
chosen by the operator. If specified it’s shown in hierarchy window instead of the Object Class. The 
ObjectID can also be used for search querries. 

• Usage: 

is an alphanumerical (may consist of letters and digits), non unique identifier for the Object which can 
be chosen by the operator. 
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• Object Class  

The object class can be edited for checked out units (cf. 2.6). All classes that are common in CityGML 
are available for selection. The most important classes in CityGRID® are: 

o Building 

o Cut-out Object  

o Underground Building 

In order to apply changes, the Unit must be triangulated (cf. 3.1) before saving it!! 

2.8.4. Element Complex Properties 

If an Element Complex is activated in the Hierarchy Dialog as the Active Complex the properties window is shown 
in case the option show properties dialog is selected in the right-click-menu of the Hierarchy Dialog. 

• The field Elements shows the number of Elements in the 
Element-Complex. 

• The ComplexKP indicates the unique database key of the Object, 
the ComplexID a consecutive number of the Object used by the 
XML-Modeler. 

• Each Element Complex can be given any Usage in order to 
support the logical structure in the hierarchy window (e.g. garage, 
shed, lift annexes, etc.) 

• Level of detail: The LOD of each element complex can be defined 
individually. The available options are LOD 3 (detail) and LOD 2 (form). By default the software sets 
the LOD of detail element complexes to detail and main element complexes to form. 

 

Note: Be aware that the LOD of main element complexes is always to be set lower or at least equal 

to the LOD of its detail element complexes. Increasing the LOD of a main element complex will 

have an effect on the LOD of its detail element complexes immediately. 

• LoD1: The LoD1 (Box Model) of a Unit is usually generated automatically in an average elevation of the 
eave line. If a given value for the elevation of the eave line shall be used, the check box left of “LoD1” 
must be activated and the elevation to be used can be declared (as absolute height). In order to apply 
changes, the Unit must be triangulated (cf. 2.9.1) before saving it!! This parameter is available for main 
element complexes only. 

• The depth under terrain option defines an additional distance in meter, the facade will be extruded 
under the lowest point of the covered terrain area. This option allows for generating cellar objects and 
is available for main element complexes only. 

 

Note: Positive values generate an extrusion under the ground, whereas negative values will let the 

building float above ground. 

2.8.5. Element Properties 

If an Element is activated in the Hierarchy Dialog as the Active Complex, the window "Active Layer” (cf. 2.9) is 
docked on, case the option show properties dialog is selected in the right-click-menu of the Hierarchy Dialog. 

This window contains the Properties of the Element-Complex, of the Element, of the Active Layer (cf. 6.8), and the 
Selection-State-Line (cf. 3.2). 

• The field LoD shows the Level of Details of the Element, ElementKP indicates the unique database key, 
the ElementID a consecutive number of the Element used by the XML-Modeler. 

• Each Element can be given any Usage in order to support the logical structure in the hierarchy window 
(e.g. saddle roof, Courtyard facade, etc.) 
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• The element class indicates the interpretation of the element (e.g. roof, ceiling, protrusion, facades, floor). 
In general it cannot be modified except between roof and ceiling (a ceiling – on the contrary to a roof – has 
the default colour grey and is not considered at the automatic roof texturizing process. 

• The face generation type defines the algorithm after the areas are 
differentiated. In general the face generation type is defined 
automatically. The orientation of the created areas plays an 
important role at this process. If the direction of the normal has been 
set in a wrong way, it will be corrected automatically at the process 
of triangulation. In addition the face generation can be set bilaterally. 
By doing so, the areas will be doubled with both area normals. 

A special case is the face generation type “frozen face net”. In this 
case the existent (or directly with 3D-studio methods edited) faces 
are adopted and not newly derived anymore. 

•  Extrusion comprises the parameters for the Number of Extrusion 
Directions, the Extrusion Type and the Extrusion Direction itself.  
Generally, every element has precisely one extrusion direction, 
which is specified by 0/0/-1. In special cases, it may also happen 
that different and/or additional directions are set, e.g. with elements 
in Detail Element Complexes which are bounded by their associated 
elements in the Main Element Complex (cf. 5.4), or tubes.  

Extrusion Types define the modality of extrusions. Only set the 
Extrusion Type to generate the face element by extrusion. This is 
typically the case with façades of Main or Detail Elements. The 
following types are available at present: 

o Terrain: Extrusion projects all points on the terrain, determines the lowest pierce point, and 
assumes its z value as target size for the extrusion. 

o Terrain with Ground: Functions similarly to the Terrain Extrusion Type. The difference here is that 
a ground element is generated automatically at the lowest determined height of the façade 
element. Since this ground element is generated without the associated lines, it adapts itself 
automatically to a change in terrain model with every triangulation.  

o Parent Element: Generates the faces until they intersect with the faces of the associated parent 
element. This Extrusion Type is applied to Detail Element Complexes which protrude above the 
roof, (e.g. dormers). 

o Parent Element with Hole: Similar to the previous Extrusion Type. The only difference is that all 
faces in the parent element inside of the extruded area are omitted. This Extrusion Type is used 
for details which are located under the roof (e.g. patios). 

o Parent Element with Auto-Terrace 

If this Extrusion Type is set and the Detail Element Complex is entirely below the roof of the 
parent element, the faces are generated analogously to the previous Extrusion Type, which 
means, that the faces of the parent element within the extruded area are omitted. However, if a 
Detail Element Complex with this Extrusion Type is not completely below the roof of the parent 
element, no faces are left out, the faces are generated as with the Extrusion Type Parent 
Element. 

o Not set: If the face is created by triangulation, the Extrusion Type is not set. 

• Finally a default material consisting of a colour and a transparency value between 0 (opaque) and 1 
(fully transparent) can be assigned to the Element. This Element default material will be stored 
together with the Element and overrides the user defined default colour (cf. 2.4.4). 

• User-defined colour settings can be adopted for all areas of the same element in the right-click menu 
of the layer properties. 

The Layer Properties will be described in the next section, the Selection-State-Line in section 3.2. 
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2.9. Active Layer 

The geometric data of Elements are grouped in various layers. For various line types a separate layer is available. 
Furthermore, a layer for faces is available. 

CityGRID® implements a face generation algorithm optimized for building data. Faces are generated automatically 
from significant building lines. The lines of different layers are used in different ways.  

It is the task of the operator with the Modeler to edit the lines so that the faces are generated correctly. In the current 
software version, although the faces can be edited directly, they are in general not stored, except elements with 
face generation type set to frozen face net 

Editing actions can only be done in the active layer of the active Element, which can be selected in the window 
“Active Geometry”. There, the working level (point, line, polyline, or face selection mode) can be selected. 

• Visibility:  

The checkbox Visibility (“V“) overrules the general visibility and controls the visibility of a specific layer. 

• Linkage (Bindings):  

If a vertex/segment in the active layer is moved, all identical vertices/segments/surfaces in other 
layers of the same Element Complex are also moved, if the linkage to these layers is active. Links can 
be disabled interactively in order to edit geometry of different layers independently.  

To disable the bindings, the Bindings-button  on the button bar, below the layer selection, is 
available. This is, as well as the bindings, active by default. Click to disable all kind of bindings (general 
and special) or enable bindings again. Every triangulation activates all bindings as well as the bind 
button. 

• Special-Connection (Master-Slave and 2D):  

Express a data-based combination of layers. 

Master-Salve 

A line can be the master to an identical line in another Element of the same Element Complex, e.g. the 
eave line of the Element Roof is the master to the upper facade line (except there is another Element 
Protrusion in between). Then, the master line has the sign “M“. The slave line will have the sign “S“ in 
the respective column. 

Both the master and the slave line may be edited. In both cases, the corresponding line in the other 
Element is changed in the same way. Master-Slave relations can temporarily be removed by clicking 
“M” or “S” in active Layer window. 

2D 

2D relations express the connection of two layer in XY position. Modifications in this level will 
automatically transferred to the second layer of this relation, whereas modifications in Z are only 
applied to the active layer. 

 
 

Note: When changing the active layer the zoom is adjusted to the extents of the lines in this layer, if the 

option “activate auto zoom” in the right-click-menu in the layer window is selected (cf. 2.7.2). 
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2.9.1. Layer Properties 

The layer properties are shown on the window of the Element Complex properties and Element properties (cf. 
2.8.4). 

Depending on the active layer, information is given about the content of the layer: 

• For line layers, the number of polylines in the active layer and their total number of segments and 
vertices are displayed. 

• For face layers the number of texture images, the number of faces and the number of vertices is 
displayed. 

In addition, the Name line contains the layer name of the active layer as freely accessible text. If the layer is a 
system layer of CityGRID®, the layer name cannot be changed. On the other hand, all user-defined layers can be 
renamed using this line. 

2.10. Warnings window 

In the course of working with the CityGRID® Modeler it will always happen that building models show topological 
errors (askew intersecting rooflines, not synchronous break lines, etc.) have. Such errors must be corrected by 
modeling technique to make correct surface models of the buildings. The check for topological correctness of the 
models takes place in the course of triangulation (see. Manual CityGRID® Basics), which is triggered in the Modeler 

by clicking on the button  Triangulate/Apply changes (cf. 1.7.5). Once at least one topological 
problem situation is found, the warning window opens. 

Layer-Visibility 

Layer-Bindings 

Special-
Connections 

Line-Layer 

Point-Sub Selection 

Segment-Sub selection 

Polylinie-Sub Selection 
All Element Surfaces 

Activer Layer 

Recycle Bin 
Surface-Layer 

Surface-Sub-Selection 

Bindings-Button 
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In this any warning constitutes a separate line and provides information about the UnitID, the affected Element 
class and the type of warning. 

 

Note: It often happens that a problem location triggers several warning lines. Once the trouble spot has been 

fixed are-triangulation will remove all affected rows. The number of lines is thus not a criterion for the total 

number of issues inside a building! 

 
By double-clicking on a warning line in the Warning window, loads the affected unit in the viewport and focuses on 
the problem area. This is highlighted by 3D crosses in the viewport. If the problem location is a line segment, the 
3D crosses indicate the start and end of the relevant line segment. 

 

Advice: Once the viewport has focused on the problem area, the building lines can be edited and corrected 

using editing tools of Modeler (see. 3). The effectiveness of editing can be determined by re-triangulation. 

The warning window can remain open while editing. 

If the warning list is created by triangulation from CityGRID® Modeler it can be assumed that all of the listed units 
are part of the active model (cf. 2.1) and therefore can also be loaded in the viewport. When externally generated 
warning lists (CityGRID® Administrator CityGRID® Scout, DWG2XML converter, etc.) are integrated via button 
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, it is possible that the Units of the warning list are not part of the active model and therefore can’t be 
loaded. The viewport shows in this case is an empty space. 

 

Advice: To see the active complex (see.2.7.2) in the viewport, select the "Auto Zoom" in the right click menu 

of the hierarchy window (see Figure in Section 2.7.1.. 

The buttons  or  can save the currently displayed warning list. Save writes the list in the 

log file of the Modeler, Save As allows saving the list to a desired location. The button  terminates 
the warning window. 
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3. Editing the Geometry 

The main goal of the CityGRID® Modeler is to support the operator in editing the line geometry of buildings until 
CityGRID® derives the surfaces correctly. Typical tasks of editing are: 

• Adjust topologies (merge non-snapped vertices, adjust intersection lines) 

• Complete missing lines 

• Detach lines to Detail Elements etc 

In the next section some ruling principles are described, which apply when editing with the Modeler. Subsequently, 
typical editing actions are described in the detail. 

3.1. Ruling Principles for Editing 

1. Version Management: Only a checked-out version can be edited (cf. 2.6) 

2. Active Complex: Only the Active Complex can be edited (cf. 2.7) 

3. Active Layer: Only lines in the active layer can be edited. (cf. 6.8) 

4. Bindings: If a vertex of a line is changed, all other lines of the active Element and of other Elements of the 
same Element-Complex, which have the same vertex, are changed as well, if their bindings are active. If 
this is not desired, the bindings can be deactivated in the layer window (cf. 6.8). 

 

Advice: If you have forgotten to deactivate bindings, you can use “Undo” of Autodesk 3D Studio Max for 

undoing the last editing action. In this step, all actions of bounded lines are undone, too. 

1. Snap, Axis Restriction, etc.: For editing the capabilities of snap and axis restriction of Autodesk 3D Studio 
Max should be known. 

2. 3 representations of building models: 

When loading a Unit, all three representations are synchronized with the state stored in the data source 
(database or XML-file). 

When editing, only the Autodesk-Max representation is changed.  
When triangulating, the Modeler representation is adopted to the Autodesk-Max representation. This step is 
necessary after nearly all editing actions (e.g. also after moving Objects by drag & drop or after deleting 
Objects, …) 

When saving, the Modeler representation is stored to the data source. Afterwards a reload is triggered. 

 

Note: If more than one Unit was changed, the saving process first saves the Active Unit. Afterwards, the user 

will be asked whether the other changed Units shall be saved, also. 

Hold the Shift-Key and press the triangulation button to triangulate all loaded units, regardless if units have 

been changed or not. 

Load 
Load 

Data Source 
Representation 

CITYGRID Modeler 
Representation Autodesk VIZ/MAX 

Representation 

Triangulate 
Save 
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1. Working level Point, Line, Polyline Mode: Editing actions are valid either for single vertices, for segments 
of polylines or for the entire polyline (cf. 2.9).  

2. Undo: Editing actions can usually be undone until the last triangulated state. 

3. First Edit, then Texturize: If something is changed at the upper edge of the facade, the triangles of the 
facade usually change when extruded, which might cause loss of applied texture. Typically this happens 
if the parameters of the façade changed significantly due to the changes in line geometry, so that the 
texture keeping algorithms can’t preserve the applied texture. Thus it is suggested to finish any geometric 
corrections before adding texture.  

 

Advice: Fast Triangulation: 

As described above in top 6, it is always necessary to click at “Triangulate/Apply changes” in order to take 

over the data. For large, complex Units triangulation may need some time, because all dependencies 

between Complexes must be regarded (e.g. Detail Element Complexes must be extruded again, if the parent 

roof has changed, facades must be adapted to changed Cut-out Objects, etc.) 

In order to avoid waiting each time until the whole Unit with all dependencies was triangulated, if only little 

has been changed, it is possible to start a fast triangulation. In that case, only the Active Complex is 

triangulated. The user must be aware that linked Complexes are not updated in that case! Fast triangulation 

should therefore only be used for the frequent intermediate triangulations. At the end of the editing, always 

a complete triangulation must be done. 

The fast triangulation is started by clicking at the Triangulate/Apply changes  button while 

holding the “CTRL”-key pressed. 

3.2. Selection State Line 

For editing actions geometry data (points, lines, polylines) of the active layer must be selected. CityGRID® Modeler 
searches for identical vertices in other layers and may select them too (depending on settings of bindings and 
master-slave-connections). Thus, editing actions may automatically be done in bound lines, too. 

The selection state is shown in the lowest line of the Element Properties window (cf. 2.8.5). 

The first row shows four values: - n1 - / - n2 - / - n3 - / - n4 -with: 

 Point Mode Line Mode Polyline Mode 

n1 Number of manually selected 
points 

Number of manually selected 
lines 

Number of manually selected 
polylines 

n2 Number of points coupled by a 
master-slave-connection 

Number of lines coupled by a 
master-slave-connection 

Number of polylines coupled by 
a master-slave-connection 

n3 Number of points coupled by 
bindings 

Number of lines coupled by 
bindings 

Number of polylines coupled by 
bindings 

n4 Number of points coupled by 
x/y-bindings (used for break 
lines) 

Number of lines coupled by x/y-
bindings (used for break lines) 

Number of polylines coupled by 
x/y-bindings (used for break 
lines) 

The second row indicates the selected points/lines/polylines. It shows any number of strings of type (i-x) with 

i … a number for the i-th polyline of the active layer (starting with 0) 

x … the consecutive numbers of the selected points/lines/polylines (starting with 0) 

 

Example: 

Point mode, active layer eave line of the Element Roof: 

- 16 - / - 16 - / - 5 - / - 0 - 

(0-2..5,18..19) 

Verbose description: 16 vertices of the master line (eave) are selected. 16 further vertices of the slave line 

(upper facade line of the Element Facade) are selected, too. 5 further 3D-identical vertices of other layers of 

the Element Complex are selected, too (e.g. roof lines leading to the eave). 

The selected vertices are number 2 to 5 and 18 to 19 of the 0-th polyline of the layer eave 
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3.3. Usage of basic editing tools  

The basic editing tools support standard modelling tasks in simple and complex building models. 

3.3.1. Coordinate Tool  

The Coordinate Tool  (cf. 1.7.2) can be opened/closed by the 
respective button in the column of buttons of the Edit Mode (cf. 1.7.2). 

In the left column the current coordinates are shown. In the middle column of 
checkboxes can be selected which coordinates may be changed by inputting 
new values. In the right column the new coordinates can be typed in. 

The checkbox Show Absolute Coordinates enables to toggle between the local 
coordinates used by Autodesk 3D Studio Max and the coordinates in the reference coordinate system of the data 
source. (cf. 1.8) 

The mode Mark Input Field Automatically selects the value in the input field automatically after each selecting of a 
point in a graphical window. Thus, the new value can be typed in without moving the mouse so that it can select 
the next point immediately afterwards. 

3.3.2. Move a Point  

Regard the general notes about editing in section 3.1. 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

3. Select the Active Layer. 

4. Activate Point Editing Mode  (cf. 2.9). 

5. Check Bindings (cf. 2.9). 

6. Activate Select And Move of Autodesk 3D Studio Max. 

7. Select the point.  

8. Move the point or type in new coordinates in the Coordinate Tool  (cf. 3.3.1). 

9. Click at Triangulate/Apply changes  (cf. 1.7.5). 

3.3.3. Insert a Point into a Line  

Regard the general notes about editing in section 3.1. 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

3. Select the Active Layer.  

4. Activate Point Editing Mode  (cf. 2.9). 

5. Check Bindings (cf. 2.9). 

6. Click at Drawing mode  (cf. 1.7.2). 

7. Click at the line and position the inserted point (with or without snap).  

8. Click twice with right mouse to end editing session and close tool. 
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9. Click at Triangulate/Apply changes  (cf. 1.7.2). 

3.3.4. Add a Line (e.g. a Roof, Ridge or Eave Line)  

Regard the general notes about editing in section 3.1. 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

3. Select the Active Layer.  

4. Activate Line Editing Mode  (cf. 2.9). 

5. Click at Drawing mode  (cf. 1.7.2). 

6. Insert the line between existing vertices using the snap of Autodesk 3D Studio Max.  

7. Click twice with right mouse to end editing session and close tool. 

8. Click at Triangulate/Apply changes  (cf. 1.7.2). 

3.3.5. Correct the Elevation of a Ridge Line (or Eave Line etc)  

Regard the general notes about editing in section 3.1. 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

3. Select the Active Layer. 

4. Activate Polyline Editing Mode  (cf. 2.9). 

5. Check Bindings (cf. 2.9). 

6. Select the line. 

7. Either move the line in the correct elevation using the snap of Autodesk 3D Studio Max and the activated 
axis restriction to Z or type in the absolute elevation in the Coordinate Input Tool. 

8. Click at Triangulate/Apply changes  (cf. 1.7.2). 

3.3.6. Coordinate System-Tool  

The Coordinate System-Tool can be used for defining local coordinate systems 
rotated to the world coordinate system that may be useful for modelling (e.g. 
moving points along the axis of the local coordinate system). The tool can be 
opened/closed by the respective button in the column of buttons of the Edit 
Mode (cf. 1.7.2). 

In the upper part, two possibilities of defining an individual coordinate system 
are available: 

• definition via an existing line element 

• definition via an existing face element 

In order to define a coordinate system via a line segment, proceed as follows: 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 
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3. Activate Select And Move  (cf. 3.3.2) 

4. Select the Active Layer.  

5. Activate Line Editing Mode  / Point Editing Mode  (cf. 2.9) 

6. Open the Coordinate System Tool  (cf. 1.7.2). 

7. Select the button Sel .  

8. Click Coordinate System Tool  to close tool. 

By pressing the button Sel more than once, the adjustment of the coordinate system can be varied according to 
the incoming line segment. This might turn out to be necessary at the process of the delivery of the coordinate 
system of a point selection. 

In order to define a coordinate system via an existing face element, proceed as follows: 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

3. Activate Select And Move  (cf. 3.3.2) 

4. Select the Active Layer. 

5. Activate Point Editing Mode  (cf. 2.9). 

6. Open the Coordinate System Tool  (cf. 1.7.2). 

7. Select the button Pick . 

8. Click three points to define the face element.  

9. Click Coordinate System Tool  to close tool. 

The individually defined coordinate system will be applied at once, and can be found under “Reference Coordinate 
System” in the Autodesk 3D Studio Max Main Toolbar. Each manually defined coordinate system is named 
“CityGRID CoordSys” and thus overwrites the last individually selected CityGRID® coordinate system. 

To save a defined coordinate system you can also use the Coordinate System Tool. Fill in any name in the field 
under Save coordinate system and click at Add. By clicking at Del you can delete saved coordinate systems. Each 
named coordinate system can also be found under Reference Coordinate System in the Autodesk 3D Studio Max 
main toolbar. The save coordinate systems remain available in the current session of Autodesk 3D Studio Max. 

Based on named coordinate systems you can adjust the view direction of your active viewport. Simply choose a 
coordinate system in the pull down menu and define the view direction by clicking on of the radio-buttons under 
Align active viewport. 

Use Set Element Extrusion Direction to define an extrusion direction for elements or element complexes from the 
set coordinate system. Select the extrusion direction from the first dropdown list. The second list lets you select 
the axis directions of the set coordinate system. Here, you can always select the inverse direction for each axis. 
Click on  to set the extrusion direction. This is evaluated during the following triangulation and is adapted to the 
face net. 

 

Note: Setting extrusion directions is not practical with Detail Element Complexes which are bounded to 

Main Element Complexes (cf. 5.4) since the extrusion directions in this case are already set precisely. 

 

Advice: In general, setting individual extrusion directions is only useful for the primary extrusion direction 

since it is responsible for the main appearance of the complex. Use the Element Extrusion Direction to set 

roof face windows with slanted façade faces on the roof, or to create façade details interactively. 
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3.4. Working with Special Editing Tools  

The special editing tools support editing actions, which have to be done by routine when modelling buildings.  

3.4.1. Insert Break Lines (for Vertical Roof Faces)  

A vertical Roof Face is named Break Line in CityGRID®. Such breaklines often appear at more complex flat roof 
buildings and complex roof areas. Break lines always appear as a line pair (on the layers upper and bottom break 
line). All lines on both of the layers must be 2D identical and must be available with the same line – vertex -
structure. The only difference is possible in the height. Different to all other lines in CityGRID® the position of 
digitalization of break lines is of high relevance. Break lines must be drawn anti-clockwise in order to create correct 
vertical roof faces. 

     

 

Advice: Rule of thumb: If you would go alongside the break line, the vertical face must be located on the right-

hand side. 

The editing of a point or a line segment causes the automatic adjustment of the corresponding point or line segment 
on the corresponding break line layer. This linkage can be temporarily deactivated on purpose using the modeller 
by manually deactivating the linkage and 2D relations in the layer window. (cf. 2.9). 

Regard the general notes about editing in section 3.1. 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

3. Select the active layer upper break edge (cf. 2.9). if necessary create a new layer upper break edge using the right-
click menu in the layer window 

4. Activate Line Editing Mode  (cf. 2.9). 

5. Click at Drawing mode  (cf. 1.7.2). 

6. Create a new upper break edge with an orientation, so that the break 
is right of the edge 

7. Click at Drawing mode  to close digitizing mode 

8. Select Polyline Editing Mode.  (cf. 2.9). 

9. Activate the special editing tool Edit break lines  (cf. 1.7.2). 

10. Select all break lines or only selected and select the break lines. 

11. Select the action synchronize break lines. 

12.  Click at .  

13. For all upper break edges corresponding lower break edges are generated at the same position. If the break 
line ends at the eave line, the tool tries to move the lower break line into the correct elevation. Else it is 
necessary to move it down to the right height. 
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14. Click Edit break lines  to close the tool. 

15. Select the active layer “lower break edge”. 

16. Activate Point Editing Mode.  (cf. 2.9). 

17. Select and move the lines in the correct height.  

18. Click at Triangulate/Apply changes  (cf. 1.7.2). 

3.4.2. Adjust Break Lines  

Break lines allow for modelling vertical roof surfaces. For a correct face generation, the following rules must be 
obeyed: 

• For each upper break edge, a lower break edge must exist whose vertices have exactly the same X- 
and Y-coordinates. 

• The orientation of break edges must be in a way that the break is right of the edge. 

• Break lines must not end except in the eave line or in positions where the upper and lower break edge 
converge. 

For fulfilling these conditions special editing tools are implemented in the Modeler. In section 3.4.1 synchronizing 
entire break edges was already explained (for each break upper edge a lower break edge is generated). Further the 
vertices of the break edges can be synchronized with the same editing tool, so that corresponding break edges will 
have congruent vertices. Break edges which are displaced a little bit (up to a certain tolerance) can be made 
congruent.  

Further the orientation of a break edge can be inverted. Wrongly oriented breaking edges lead to impossible areas 
in the roof or even cause a breaking up of the roof faces. 

 
Note: The special editing tool for break lines is available only in Polyline  Editing mode, if the active layer 

is a break line layer. 

 

Note: If a break line system opens into the eaves polygon with upper and lower break edge at different points, 

CityGRID® an independently determine the required orientation and correct a possibly wrongly oriented break 

line. In the case of breaklines without a connection to the eaves, any opening roof lines will be used for 

orientation. The principle is that on the side of the vertical drop, rooflines can never open into the breaking 

edge. If there are neither connections to the eaves, nor opening roof lines, there can be no automatic 

checking of the existing breakline orientation and thus no correction during triangulation. In this case, the 

direction of rotation must be adjusted via the breakline tool. 

3.4.3. Line Intersection Tool  

Task: The closed eave line polygon forms a rectangle in the eaves’ height. Additionally there is a ridge line in ridge 
height. Insert the end points of the ridge line into the eave polygon. In addition the ridge line must be 
extended/shortened, so that the facade with the gable remains planar. 

 

Note: Lower break edges must have exactly the same X- and Y-coordinates as the corresponding upper 

break edge. A break edge is a line segment with a starting, an endpoint and various inserted points. 

Combined line segments are interpreted as multiple break lines. 
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     →       
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This task is solved by the special Line Intersection Tool. 

Regard the general notes about editing in section 3.1. 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

3. Select the active layer “ridge line” (or another layer)  

4. Activate Point Editing Mode  (cf. 2.9). 

5. Select the end point(s) of the ridge line(s). 

6. Activate the special editing tool Line Intersection (cf. 1.7.2).  

7. Activate Z-coordinate fixed, if the Z-coordinate of the moved vertex 
shall not be changed. Otherwise the vertex is moved along the ridge 
line.  

8. Edit also target layer indicates whether the vertex shall be inserted 
also into the polygon of the target layer (in our case the eave line). 
Activate it for our example 

9. Select target layer allows for selecting the layer, to which the selected 

vertex will be moved (after clicking at  the any line of the target layer can be selected graphically). If a 
target layer is not set manually, the intersection will be carried out with the eave line. 

10. Click at . 

11. Click Line Intersection Tool  to close the tool (cf. 1.7.2). 

12. Click at Triangulate/Apply changes  (cf. 1.7.2). 

 

Note: This special editing tool can also be used with other layers than with ridge lines as long as the point 

editing mode is active. 

3.4.4. Include Intersection Point  

Frequently line structures overlap themselves due to inaccuracy of the original data capture. The Line Intersection 
Tool offers a method to calculate the intersection points of such warped line segments, so that a correction can be 
made more easily. 
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1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

3. Select the active layer eaves (or other). 

4. Activate Point Editing Mode  (cf. 2.9). 

5. Activate the special editing tool Line Intersection (cf. 1.7.2).  

6. Activate the Option Insert Intersectionpoints 

7. Select Execute 

8. Click Line Intersection Tool  to close the tool 
(cf. 1.7.2). 

9. Click at Triangulate/Apply changes  (cf. 1.7.2). 

3.4.5. Move a Point into a Face  

This special editing tool allows moving a point along a vertical line into a face. The position of this straight line can 
also be defined interactively based on existing geometry. 

Regard the general notes about editing in section 3.1. 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

3. Select the Active Line Layer  

4. Activate Point Editing Mode  (cf. 2.9). 

5. Make the face to which to be moved visible (cf. 2.4.2). 

6. Select the point(s) which are to be moved. 

7. Activate the special editing tool Move Point into Face Tool  (cf. 1.7.2). The window of the 
Tool opens. 

8. Define the moving axis: The following axis can be used: 

• Global X, Y, Z axis 

• Global refers to the standard coordinate system “World“ by Autodesk Max. 

• Local X, Y, Z axis  

• Local refers here to an individually defined coordinate system tool (cf. 3.3.6) 
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Advice: If a shortcut was set for the delivery of a local coordinate system, it can be directly appointed within 

this tool. 

• Selected segment  

• For this variant a line segment must be selected before the Move 
Point into Face Tool is opened. 

• Incoming or outgoing segment  

• When selecting a point either the segment directly in front of the 
point (whose end point is the according selected point), or after 
the point (whose starting point is the according selected point) 
can be chosen. The order of the points can be determined from 
the selection status bar. 

9. The following Intersection Planes can be indicated: 

• From the active element 

As an intersection layer the closest area of the element will be taken. For example: Is a point of the 
layer “General Roofline” (is located in the element “Roof”) marked and intersected, the active 
element is here the roof area. 

 

Advice: This method is used when lines of the same element are edited (e.g. lines of a roof) 

• From the selected element 

Click on the button Select Face Element and select any face in Viewport. The element corresponding 
to that face will be calculated and used as an intersection layer. By clicking the button Select Face 
Element again new elements can be selected. 

 

Advice: Use this method in order to intersect lines with areas of different hierarchy level (e.g. 

dormers with the main window) 

• From selected area 

Select one or more connected face triangles before the Move Point into Face Tool has been started 
to use this selection as an intersection layer. 

 

Advice: When choosing the area triangles, cants within a roof area can be eliminated by 

intersecting all the other points of a roof with the selected area. 

• User-defined 

Click the button  and subsequently select three points in Viewport 
(Snap will be activated automatically). These points span the intersection layers. As soon as an 
intersection layer had been defined, User defined will appear instead of Choose 3 points. Such a 
defined intersection layer remains active until a new definition or a reboot of the programme. 

 

Advice: The user-defined intersection layer does not have to correspond to a real area of the 

unit. Each position in the room, which can be defined by three points, is possible. 

10. Check Offset if required. This offset is adjusted onto the points, after having been put into the 
intersection layer. Next to the size of the offset (positive values move the points in front of the intersection 
layer), the position of the offset can be indicated. Alternatively, an offset alongside the global Z-axis or 
face normal is available. 

 

Advice: the offset is used for modelling roof area windows. Via offset it can be guaranteed that all 

roof area windows will get a fixed value. 

11. Press . The selected point(s) will be moved until they lie in the selected 
face Via little crosses the position of the points according to the pre-settings will be simulated. By doing 
so possible unrequested offsets can be corrected, before the Execute button will be pressed. In order to 
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refresh the preview, there must always be an action carried out in the properties window of the point-
offset tool. 

12. Click Move Point into Face Tool  in order to close the 
tool.  

13. Click at Triangulate/Apply changes  (cf. 1.7.2). 

3.4.6. Generate a Roof Protrusion  

This special editing tool allows to separate eave line and the upper edge of the 
walls so that protrusion faces are generated in between. 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (the Element roof or facade depending on whether the roof shall be moved 
outwards or the facade shall be moved inwards) (cf. 2.7). 

3. Select Line Editing Mode  (cf. 2.9). 

4. Select the active layer eaves or upper facade line. 

5. Select the line segments for which the protrusion shall be generated. 

6. Activate the special editing tool Create roof protrusion  (cf. 1.7.2).  

7. Select the method used for calculating the protrusion 

Horizontal Protrusion: The selected line segments will be shifted respective the given amount 

Intersection Roof/Façade: The selected line segments will be shifted respective the given amount 

and vertically intersected with the roof. This option can only be applied to façades. 

Taking over 2D ground sketch: A given 2D line information stored on a separate layer will be 

intersected with the roof, where it is lying inside the eave line. The 2D lines have to form a 
closed polyline (e.g. boundary of a building block, a ground sketch, etc…) The layer can be 

selected by drop down list or by clicking the  and selecting the line in the viewport. 

 

Note: All segment on the selected layer will be used for the calculation. Selecting vertical sections 

leads to implausible results with the creation methods "Horizontal Protrusion“ and "Intersection 

Roof/Façade“. 

The algorithm takes the x and y coordinates of the ground sketch and intersects with the roof 
shape. From this intersection point the Offset will be added or subtracted (depending on the 
sign of the given value). For visualization purpose it is strongly recommended to use a 
minimum offset to avoid identical face, which will cause flickering effects. 

 
Advice: Use this function to optimize protrusion generated with older versions of this tool.  

8. Specify Offset 

If required, use Offset to produce a global height adjustment at the position of the segments projected 
in the roof. Negative values mean an adjustment in the direction of the terrain. 

An offset is always attached after measuring the roof protrusion and adapting the associated 
individual height of each vertex point on the selected segments. Every point comprises the specified 
offset value added to z. 

 

Note: By attaching an offset, you can generate a space between the roof and the roof 

protrusion. This would otherwise not be possible using the generation methods "Intersection 

Roof/Façade" or "Taking over 2D ground sketch". If the building models are sent to a 3D 

printing method, this space is urgently needed. 
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Tip: Use this functionality to place façade top edges from previous calculations at the best 

position in the roof.  

 
Tip: The offset can also be used to integrate abstracted cornices in the building model.  

9. Type in the amount of protrusion in meter 

10. Click . 

11. 11. Click Roof Protrusion Tool  again to close the tool. 

12. 12. Click at Triangulate/Apply changes  (cf. 1.7.2). 

3.4.7. Transform Building structure lines  

This function performs a transformation of building structure lines regarding a given reference structure, thus 
enabling the user to move, rotate and scale his building due to a given ground sketch. 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

 
Advice: If more than one objects are to be transformed at once, it is possible to select entire Units. 

3. Start the Transformation tool  (cf. 5.4.2) 

4. The first page of the transformation wizard is to define the polygons acting as reference for the 
transformation. The selection lists the element layers of all complexes found, where all layer names are 
listed once only. To perform the transformation it is meaningless to which complex the selected layer 
belongs to. Select the reference layer and click Next. 

5. Based on the previous selection, the second page allows a more detailed selection by presenting all 
elements of the selected layer in the viewport. Select the desired reference polygon by clicking on it. 
Alternatively it is possible to use all polygons as reference also. Click Next to continue. 

6. Select the candidates for transformation. The selected layers you wish to transform. Click Next to 
continue. 

7. Page 4 allows to refine your selection by clicking on single polygons, or 

to create a sub selection. Click to continue. 

8. Page 5 performs the transformation based on the previous definitions 
using default values for the maximum rotation and shifting values. The 
result of this transformation is displayed in the viewport. Please note, 
that this is a preview only. The transformation has not been applied to 
the candidate geometry yet. 

 

Note: The default transformation applies shifts in x and y 

coordinates only and a rotation around z axis. There is no 

scaling applied by default. 

The proposed transformation can be accepted or adjusted by manual 
input using the provided sliders, or direct interaction in the viewport. 

Adjust automatically: 

• Max.Rotation (°): Defines the maximum rotation angle allowed. 

 
Advice: Practise shows that for buildings with a squared ground sketch maximum 

rotation angles provide suitable results. To avoid the flipping of entire buildings, 

avoid maximum rotation angles of 90° 
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The maximum rotation angle for multiple shaped buildings should be reduced to 

avoid excessive rotations. 

• Max.Offset (m): 

This defines a search radius around a transformation candidate to look for a reference polygon. 
If there a multiple reference polygons found within this radius, the one with the shortest distance 
to the candidate will be used for transformation. 

Clicking the button New triggers a new calculation of the transformation based on the new 
maximum values provided. 

Preview: 

This section provides sliders for direct interaction. All adjustment will be displayed in the 
viewport immediately. There are separate sliders for shift offsets in x, y and z coordinates (m), 
rotation round the z-axis (°), and overall scaling (%). 

 

 

 
Advice: The interaction can be done directly in viewport also. 

Use Select and Move  , Select and Rotate  to perform this 

interaction. Snapping methods can be applied to refine your input. Be aware that 

the scaling has to be done by the Transformation tool itself. 

9. Once you are satisfied with the results, click Execute to apply the transformations to the geometry. The 
same transformation parameters will be applied to all dependent complex elements. 

The Transformation tool will close automatically after the calculation. 

10. Click Triangulate/Apply changes  (cf. 5.4.2) to apply all changes. 

3.4.8. Adjust Face Normals  

In principle CityGRID® works on a line oriented approach and derives faces from the line structure using 
triangulation algorithms. But it is also possible to process just the face net (mesh) of 3D Objects as so called BLOBs 
(Binary Large Objects) and manage them together with CityGRID® data 

 

Note: Typically complex free form objects like fountains, monuments or externally modelled landmark 

buildings etc. are transferred into BLOB objects for maintenance with CityGRID®. Commonly these objects 

are converted in BLOB Conversion Manager, that can be found in menu CityGRID > CityGRID Tools > BLOB 

Conversion Manager in 3D Studio Max. (cf. 3.6.3) 

It is also possible to convert meshes using FME and the CityGRID® FME Writer. Doing so CityGML Buildings 

for example, can be transferred into CityGRID® system without deriving the line structure of the building. 

The orientation of face normal is of fundamental importance when viewing 3D data in any viewer. A face normal is 
defined by the sequence of face vertices. If a counter clockwise sequence is given (right hand rule) the face normal 
points straight up for a horizontally lying face. If the vertices are sequenced clockwise (left hand rule) the face 
normal is pointing down for the horizontal face. To be visible in any viewer each face must have counter clockwise 
sequenced vertices. 

CityGRID®ensures that automatically created faces have the correct orientation (“pointing away from the building”) 
so that they are visible in 3D viewers. But as the faces of building imported from outside of CityGRID® as BLOB 
objects have been generated elsewhere, it can happen that some faces have the wrong orientation. Whenever this 
happens it appears as if something is missing from the building (see picture below: left side wrong oriented face 
normal, right side the corrected face) 
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To correct such cases the Face Normals Tool  is used: 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

 
Advice: Each hierarchy level up to the model level can be chosen. The function affects all lower 

hierarchy levels automatically, except the detail element complexes. They can be integrated or 

excluded via user setting (see below). 

3. Click Face Normals Tool  (cf. 1.7.2). The property window of 
the tool comes up, waiting for the definition of the correction 
parameters  

4. Define Range: 

This parameter defines on which hierarchy level the tool should be 
applied. 

• Only active Complex: Affects the currently activated complex in hierarchy window and all subsequent 
hierarchy level, except the detail element complexes.  

 

Example: A unit with one object, two element complexes and two detail element complexes 

would have the following actions carried out if selected at object hierarchy level 

Only active complex affects the object and therefore also the element complexes and within 

them the roof and façade elements, which would be swapped. But no changes would be 

made on the faces of detail element complexes. 

• Active Complex with Details: Functions the same as Only active Complex, but includes all detail 
element complexes. 

• Selected Faces: This mode can only be used if an element (e. g. roof) is selected in the hierarchy 
window. The tool will swap all selected faces on the active element and has no impact on unselected 
faces or other complexes. 

5. Select Mode 

• Flip: Swaps all faces, regardless if different orientations are present in the face set 

• Unify: Analyzes all faces for opposite oriented face normals and unifies the face normals based on the 
majority of the found orientations. 

 
Advice: After Unity it might be necessary to run flip mode, if the unified faces are oriented in the 

wrong direction. 

• Manual Flip Mode: Enables an interactive flip mode in the viewport at element hierarchy level. Be 
aware that flip mode can only be used within the activated element.  

• Hit right mouse button or click Manual Flip Mode button to end flip mode. 

6. Click Face Normals Tool  (cf. 1.7.2) again to close tool. 

7. Click Triangulate/Apply changes  (cf. 5.4.2) to apply all changes. 
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Note: The Face Normals Tool works with all CityGRID® complexes, regardless if the faces were created 

by CityGRID® or not. If the tool is used on CityGRID® generated faces, the orientation of the faces will change 

in viewport but at triangulation the system will detect the wrong oriented faces again and correct the 

orientation automatically. To change CityGRID® generated faces the face generation type must be set to 

frozen face net (cf. 2.8.5) prior to usage of the Face Normals tool. 

3.4.9. Split Units  

The semantic formation of a building can be modelled in CityGRID® by the given 
complex structure (unit to detail element complex cf. Manual CityGRID® 
Basics). But in case of too large complexes, due to restitution errors (two 
adjacent buildings are recognized as one or terraced houses) it might be 
necessary to split the unit into independent complexes before modelling the 
semantic formation of the complexes. For that purpose the Split Tool exists in 
edit tools palette of CityGRID® Modeler. The tool always operates at unit 
hierarchy level and splits one unit up into two. 

1. Check out the Unit  (cf. 2.6.1). 

2. Select element Roof from to be split unit as Active Complex (cf. 2.7). 

3. Create a layer containing the split polygon, e. g. Auxiliary Line (cf. 4.1) 

4. Draw the split polygon on the previously created layer 

5. Select active complex at unit hierarchy in hierarchy window (cf. 2.7.2). 

6. Click Split Tool  (cf. 1.7.2) 

7. Click button  and select split polygon in viewport. The corresponding layer 
is displayed in property window of Split Tool immediately. 

8. Click button  to execute the split. 

9. Click Split Tool  (cf.1.7.2) again to close the tool 

10. Click Triangulate/Apply changes  (cf. 1.7.5) to apply all changes. 

After the active unit has been split into two separate units using the Split Tool, one unit is given the UnitID 
from the original unit and the second unit is applied a generated UnitID. If the UnitID needs to be changed, 
first save the unit and open afterwards the unit property window (cf. 2.8.2) 

 
Example: In the picture below valid and invalid split polygons are shown. Examples a) – c) show valid input 

situations for Split Tool and the corresponding results. a) has a single split line that extends over the 

perimeter of the eave line, b) displays a split polygon line that is short of the eave line  and c) shows a closed 

polygon as split line. 

Examples d) – f) are representing invalid split situations. In example d) two split polygons are given, e) has a 

polygon with self intersection and f) shows a line configuration that has only one intersection with the eave 

line. The second intersection will be computed by extension of the last polygon segment, which leads again 

to a self intersection split polygon. 
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Note: Textured units can also be separated without losing the applied texture. After execution of Split Tool 

the split units will be displayed untextured, but both units still have their texture assigned. Only after 

triangulation the applied texture will be displayed on both units again! 

 

Note: Only one connected line drawing (polygon) is allowed on the split layer. The polygon must not self 

intersect but may have the same start and end point (closed polygon) 

In case the split polygon extends the eave line polygon of the to be split unit, only the part until the intersection 

with the eave line will be used for splitting. 

In case the split polygon is too short to form an intersection with the eave line polygon of the to be split unit, 

the split polygon will be linear extends until the intersection is established. 

3.5. Modelling with 3D Studio tools inside CG Modeler 

 

Note: Modelling with 3D Studio Max is an expert mode that requires modelling skills in 3D Studio Max. 

Questions about 3D Studio functionalities and modelling techniques need to be addressed to the Autodesk 

community or local authorized Autodesk Support. On the part of UVM system no 3D Studio support is offered. 

For further detailing of existing CityGRID® models, it is possible to model faces of elements with 3D Studio Max 
function, directly from inside CityGRID® Modeler. The surface mesh can be processed with all 3D Studio Max 
functionalities and modelled freely. After completion of modelling work the modified mesh can be put back under 
control of CityGRID® and managed together with the triangulated surface data. Affected elements are set to face 
generation type “frozen face net” (see Manual CityGRID® Basics) and therefore no longer changed by triangulation. 
All meaningful surface-functions, especially the texture of the tool Modeler, can be used on the newly created 
mesh. 

 

Note: Material allocations of 3D Studios are not supported and will be lost at saving of CityGRID® data 

structure. 
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In addition to editing existing meshes, new complexes can be formed, which initially only act as empty containers. 
Construct any mesh inside this containers, so buildings can arise outside the CityGRID® triangulation algorithm 
completely. Creating the empty container is allowed at all hierarchy levels. 

3.5.1. Edit existing meshes with 3D Studio functionality 

1. Check out the Unit  (cf. 2.6.1) 

2. Select any element as an active complex (cf. 2.7.2). 

3. Select face generation „frozen face net“ in Element properties window. (cf. 2.8.5) 

4. The mesh can now be edited with 3D Studio functions. All available functions and modifiers may be used. 

 
Advice: If modifiers have been applied to 

the mesh, the surface network must be 

converted into an editable mesh again. 

The relevant function can be found in the 

right-click menu of the active viewport. 

 

5. Click Triangulate/Apply changes  (cf. 
1.7.5). 

 

Note: Editing in 3D Studio Max and triangulation in CityGRID® Modeler can be repeated in loop. 

3.5.2. Creation of Complexes and modelling with 3D Studio functionality 

1. On desired complex level in hierarchy window invoke the right-click menu and select the function Create 
new complex. 

2. Select Line-based, if new complexes will form faces by CityGRID® triangulation algorithm, or Face-based, 
if the areas will be built through 3D Studio functionality. In both cases, an empty complex-container with 
one element is created. 

 

Note: In context menu Face-based must be selected if the modeling with 3D Studio is to take place. 

Line-based calls for the construction of lines on the CityGRID® system layers to derive a surface by 

triangulation. 

 

 
Advice: Element class of the container can be changed at the element properties window. (cf. 2.8.5) 

3. The mesh can now be edited with 3D Studio functions. All available functions and modifiers may be used. 

 
Advice: If modifiers have been applied to the 

mesh, the surface network must be 

converted into an editable mesh again. The 

relevant function can be found in the right-

click menu of the active viewport. 
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4. In hierarchy window select the element of the container and activate the surface layer in the Layer window 
(cf. 2.9) 

5. Activate function Attach from 3D Studio Command Panel and click the created object in the viewport. 
Doing so the object is transfered to an CityGRID® object. Disable Attach afterwards. 

6. Click Triangulate/Apply changes  (cf. 1.7.5). 

3.6. Embed External Data Files  

3.6.1. Embed CityGRID® data 

In order to support modelling work external CityGRID® models from databases and XML-files can be linked (read-
only) to a loaded model. Such embedded data sources can be used as help objects, e.g. when snapping, as well 
as data suppliers for units which are being edited. From linked data sources any complexes can be moved via drag 
& drop to the active complex, but also only single layers or line segments. 

1. Choose CGModeler > Add external data source via the menu. 

2. Select data source. 

 

Note: Only data sources with up to date schema can be linked as external data source. If a data source 

with deprecated schema is selected an info text pops up and the linkage process is canceled. In such 

a case first load the data source in Administrator (database) or Modeler (XML or database). CityGRID® 

will recognize the deprecated schema and start the update process automatically. After successful 

schema update the data source can be linked as external data source again. 

3. Click Load in order to link the model 

In the hierarchy window the model is inserted as entry. Units of this 
model will not be established yet in this step. 

4. Select the linked model entry in the hierarchy window. A properties 
window opens in which the units to be loaded can be defined. 

• Access mode 

Automatic search: Based on the outer polygon of the active unit, 
units from the linked data source are loaded in a certain buffer. 

Under Buffer the buffer amount can be specified. 
Ignore actively loaded units suppresses the establishment of 
units existing in Viewport in the linked model. 

• Display mode 

Here the display of linked units can be defined. 

• Coordinates Offset (m) 

Offset values in metres can be specified here if the actively loaded model and the linked model use 
different coordinate systems. 

• Level of Detail 

Select a desired generalization of the linked units. 

 

Note: Modifications at level of detail have only impact on models which are linked from a database. Models 

from XML files are always loaded in the highest LoD (detail). 

5. Click  in order to load the linked units in Viewport. 

If a new editing area is loaded in the active model, the linked areas automatically adapt to the adjusted 
settings. For modifications, steps 4 and 5 have to be executed again. 

6. Press to end the connection between the active model and the linked data source. 
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Advice: Several external data sources can be linked to the active model simultaneously. For each of these 

models Display properties can be assigned individually. 

 

Note: Linked models are identical to actively loaded models, with the only difference that no editing 

procedures can be taken in linked models. Via drag & drop all the existing complexes from a linked model 

can be moved to the actively loaded model. Layers can be transferred via an ordinary drag & drop procedure 

but also via drag & drop with the right mouse button. In the last case a context menu appears at the hierarchy 

windowed the target, in which the mode of the drag & drop procedure can be specified. If you drag the model 

vertices of the linked dataset by drag & drop, all the loaded Units in the linked dataset are copied to the 

destination. 

3.6.2. Linking AutoCAD files 

Using the File-Link-Manager of Autodesk 3D Studio Max, AutoCAD DWG or DXF files can be loaded, the data 
of which can be used as assistance for editing, because they can be snapped to. 

1. Open the File Link Manager of Autodesk 3D Studio Max in the Menu File. 

2. Select an AutoCAD DWG or DXF file. 

3. If applicable, exclude some layers of the CAD file from display (“Exclude Objects by Layer“). 

4. Attach the file 

5. Move the new objects to the local coordinate system using the menu CGModeler>Move Nodes to Local 
Coordinate System. In general, all objects can be selected. Click at button Local Coord. 

6. If the file is not needed any more, we recommend detaching the file again using the menu File > File Link 
Manager. 

 

Note: Autodesk 3D Studio Max is not capable of working precisely with large coordinates. The programme 

has access to 8 digits in total. If coordinates with more digits appear, Max rounds automatically; this leads 

to imprecision. In order to gain full precision of the linked data, it is recommended to already correct the 

DWG/DXF files for the offset values in a CAD programme, and then embed the data into Max. In this case 

step 5 can be left out since the linked data already fit with CityGRID® data. 

3.6.3. Integrating point clouds 

With 3D Studio Max version 2025, point clouds can now also be loaded as auxiliary objects from the Shaper. 
To do this, a building must be actively loaded from the Shaper (see 3.6.4). Via the menu item CityGRID - > 
Modeler -> Auxiliary objects -> Import point cloud from CityGRID Shaper, the point cloud can be loaded 
from the active selection area of the Shaper and used as a snap object. The shaper point cloud can be selected 
via the "Select from scene" selection function in order to then change the view via the command panel. Here 
you can set how many points are to be displayed, which color channel is to be used and the point size can be 
changed. 
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The point cloud can be set as the snap target via the grid and snap settings. 
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3.6.4. Communication with external CityGRID® Application (Shaper) 

To enable the editing of CityGRID® buildings from other 
CityGRID® applications, there is the possibility to set the 
data source to External and thus put the Modeler in waiting 
position, provided that the external application has already 
been started.  

As soon as the command is given in the other application 
(currently only CityGRID® Shaper), the corresponding 
building is loaded, and all editing functions of the Modeler 
are now available.  

After finishing the editing (and saving the building), Modeler 
must be put back into the waiting position by clicking on the 
button Working Set Dialog.  
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3.7. BLOB Converter 

3dStudio offers a wide range of supported import formats, which can be used to read in 3D data from various data 
sources. To use this data within CityGRID®, a conversion using the BLOB converter is required. This is a tool for 
converting any geometry object in 3dStudio to CityGRID® XML data structure. It is a standalone tool and can be 
started independently from any CityGRID® application.  

 

Note: BLOB converter scans the file for objects of type editable mesh and finally converts it to CityGRID® 

objects. Therefore we recommend transformation of the imported geometry data into editable meshes and 

logical grouping prior to the conversion process. (refer to 3D Studio Max manual for further details). 

Finally, all texture paths used must be able to be resolved correctly. Currently alternative locations that can 

be specified via 3D Studio functions will not be evaluated. 

1. Open menu CityGRID > CityGRID Tools > BLOB Conversion Tool to start BLOB conversion tool.  

2. Define Mode 

• Selection Method: The Selection method can handle two different scenarios. The Complete Scene 
option will scan the entire 3dStudio scene for convertible objects, whereas the Manual Selection 
option restricts the candidates to a subset of selected objects. 

• Conversion Method: The conversion method has three options: 

3. Node to unique Unit converts every object in the scene to a single CityGRID® Unit. This is the standard 
option. 

4. Only one Unit option merges all found object into one single CityGRID® Unit. The different object will be 
treated as element complexes in the resulting XML file. 

5. The Use group structure option is similar to the first option, but converts grouped objects into one 
CityGRID® Unit. Use this option for semantic formation of converted objects.  

• Generation method: The Create new Units option will add new units to the unit list every time the 
conversion process is started. 

• The Add to existing Unit option grants access to the unit list to choose an existing unit from. The found 
objects will be added to that unit as element complexes then. In combination with the Manual 
selection method this offers a way to build fairly complex units.  

 

 

Advice: The tool distinguishes between data conversion and writing to XML. The conversion process 

can be triggered several times. This will add new units to the unit list. Finally the save button will 

write this list to the CityGRID® XML file.. 

6. Statistics  
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The statistics window shows the number of converted Units and textures which will be written to the XML 

file. Clicking the  button will clear that list. 

7. Settings 

The settings section gives access to features as the visual representation of the CityGRID® Units (this can 
be changed later), the Model name and the naming convention for the Units. Through the user defined 
option a naming template can be defined which will be enumerated automatically. The detect 
automatically from scene parameter extracts the UnitIDs from the 3D scene using the object names. 
These can be changed in the object’s properties. 

Finally the objects can be transformed by Coordinate Offset to a given coordinate system. As 3dStudio is 
restricted in the number of digits for storing coordinates, many models are created in some local 
coordinate systems. For proper geo referencing it may be necessary to add a coordinate offset to this local 
system. Be aware that the entered offset will be added to the coordinates. 

8. Press button  to start the conversion process. 

9. Press button  to export all converted data to a CityGRID® XML file. 
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4. Operations with lines  

4.1. Add a Layer  

Building lines are assigned to specific predefined layers. In order to create lines in a layer which is not yet available 
for the active complex, a new layer can be created as follows:   

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

3. Select Line Editing Mode  (cf. 2.9). 

4. With a right click in the Layers Selection window a context menu appears in which a new layer can be 
created. By moving the mouse on the area Create new layer an additional context menu opens where 
all producible layers appear. Already created layers cannot be created a second time. 

 

After creating the new layer new lines can be digitized into that layer. However, if triangulation is started, empty 
layers will be removed again. 

4.2. Change Line Type (Layer)  

During the face generation, lines are treated in a different way depending on the layer they belong to. Thus it may 
be necessary to move lines into another layer. 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

3. Select Line Editing Mode  (cf. 2.9). 

4. Select the line(s) to be changed 

5. Move the source layer onto the target layer via drag & drop in the layer window. Instead of the mouse arrow 
a plus symbol appears for valid target layers and/or a propitiatory sign in all invalid target areas. If 
segments have been selected, a message appears asking if the selection, the whole layer should be 
copied or the whole process should be cancelled. After one of the three options has been selected, the 
process has been completed. Deactivate the linkage (cf. 2.9) to the source layer in order to avoid a 
deletion of the segment on this layer. 

 

Example: Move lines from layer “Auxiliary line” onto “General roof lines”. Select segments on layer “Auxiliary 

line”, click layer “Auxiliary line” in the layer window and keep the button pressed and move it onto the layer 

“General roof lines”. Click the layer “General roof lines” and deactivate the checkbox at the layer “Auxiliary 

line” in the column “B”. Press Key DEL to delete the selection. 
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As an alternative to the procedure mentioned before another procedure via the context menu is available. 

 

Note: For opening this menu without changing the Active Layer, you need to click into the lower free space 

or the border of the Layer window. In this way a line can be moved also to a layer, which is not yet available 

for the active complex. 

4.3. Copy/Move a Line into another Building Complex  

In this way, lines can be moved/copied into another Object or even into another Unit (if that Unit is checked out). 

1. Check out the target Unit  (cf. 2.6.1). (the Unit, the layer belongs to, into which the line is to be 
moved). 

2. Display the lines of both the source and the target complex. (cf. 2.4.2) 

3. Select steps 1-5 of section 4.2 (optional way). 

4. Now, in the context menu select Layer in Viewport. 

5. In the state line (bottom of Autodesk 3D Studio Max) a line “Select target layer” appears. 

6. By clicking at any line of the target layer the layer is selected and the selected line(s) are moved/copied to 
that layer. 

7. You can move the selection via drag & drop. There is always a copy procedure being executed maintaining 
the layer. The target complex has to be opened in the hierarchy window up to the element, in which the 
selection should be moved. Now you move the source layer from the layer window onto the target element 
in the hierarchy tree via drag & drop. Instead of the mouse pointer a plus symbol for valid targets or a 
propitiatory sign at all invalid target points appears. Again the question appears whether the selection, the 
whole layer should be copied or cancelled. Spare lines can be deleted at the source layer after the copy 
process. Linkage does not have to be considered in that case; they do not act as inter-complex. 

 

Note: When moving lines links have to be taken into consideration! Since an offset procedure consist of a 

copy and deletion procedure, moving the line(segments) has an effect on all 2D identical line(segments) 

so that these would also be moved. Especially at line(segments), which are 2D identical with the outer 

bounding polygons (eaves), this can lead to unexpected effects. In that case deactivate the linkage in order 

to guarantee that only demanded areas are moved. 
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5. Operations with Complexes  

In this section actions are described that change the logical structure of a Unit (Unit, Objects, Element Complexes, 
etc:) such as moving or deleting an Object, etc. These operations can be done by Drag & Drop in the Hierarchy 
Dialog or in its right-click menu. 

 

Note 1: These buttons can only be made available for a checked-out version a Unit (cf. 6.4). The target Unit 

must be checked out as well. The following actions such as all editing actions are performed in the Autodesk 

3D Studio Max representation of the data. Afterwards, always press the triangulation button in order to take 

over the changes!! See section 3.1 for explanations about it. 

5.1. Create empty Complexes  

1. Check out the Unit  (cf. 2.6.1). 

2. select hierarchy level above the complex to be created in the hierarchy tree 

• Unit level for a new object 

• Object level for a new Element Complex  

• Element complex for a new Element 

• Element for a new Detail Element Complex 

3. Select Create new complex in the right-click menu of the hierarchy window. 

4. Choose the construction type of the new complex: 

• Line-related create a new 
complex using the CityGRID® 
line structure. Such complexes 
will receive the surfaces via the 
CityGRID® triangulation. 

• Area-based forms a complex 
without lines. The surfaces 
must be created directly using 
3D Studio Max design methods 
and can be managed as a frozen 
land mesh in the CityGRID® 
data structure. The 
triangulation will have no effect 
on the complex. 

In the pop-up context menu, all 
available complexes appear. 

5. Fill newly created complexes with contents via drag & drop. (cf. 4.14.3)  

 

Note: Empty complexes will be deleted during triangulation. 

5.2. Create capped elements  

Certain polygons in CityGRID® are related to each other one by one e.g. eave line and facade upper edge), they 
create a Master-Slave relation (cf. Manual CityGRID® Basics). If polygons are already existent at the conversion to 
CityGRID®, the Master-Slave relations are automatically set. Sometimes – during the modelling - it might be the 
necessary case to set these Master-Slave relations after the event, for example, when a Floor element is inserted. 
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Next to the creation of a corresponding element, the corresponding polygon is simultaneously copied onto the 
corresponding layer and the Master-Slave relation is set up. 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

3. Select Create adequate element in the right-click menu. 

4. Click at Triangulate/Apply changes  in order to apply modifications. (cf. 1.7.2) 

 

Advice: Click the following layer in order to create adequate elements with the related layers. 

element layer  element Layer 

Roof Outer Boundary: Eave → Facade Upper Facade Polygon 

Facade Upper Facade Polygon → Roof Outer Boundary: Eave 

  → Ceiling Outer Boundary  

Facade Lower Facade Polygon → Floor Outer Floor Boundary 

Floor Outer Floor Boundary → Façade Lower Facade Polygon  

5.3. Detach Complexes  

Modelling Roofs can often be done more efficient, if details at the roof are detached as separate Objects/Detail 
Element Complexes. First, the lines are prepared in an existing Object/Element-Complex. At this stage it is useful 
to pay attention to create a closed outline of the Object/Detail Element Complex to be detached. Subsequently, 
the lines which are to be detached are selected and declared as separate Object/Detail Element-Complex. 

The difference between detaching as “Detail Element Complex“, “Element Complex”, and “Object” is as follows:  

• A Detail Element Complex has a Parent Element. Its outline lies (mainly) within the eave line of the 
parent’s roof. Its facade is extruded down to the roof of the Parent Element for all parts lying within the 
parent’s outer polygon. All other parts are extruded to the terrain. Typical Detail Element Complexes 
are dormer windows etc. 

• A (main) Element Complex or an Object is an independent building complex of the Unit. Its outline is 
usually not enclosed in the outline of any other building complex. Its facade is extruded down to the 
terrain model. Each object has at least one main Element Complex (consisting of roof, facade and 
maybe a protrusion). Typical Objects besides the main Object are sheds, garages, elevators, etc. 

• Concerning face generation, there is no difference between detaching as Object or as Element-
Complex. 

For finding candidates to be detached, an automatic algorithm is implemented that searches for closed polygons 
in the given layers or in selected lines. When detaching these polygons they are converted into eave lines. Lines, 
which lie within one of these closed polygons, are added to the automatic candidate suggestion and assigned to 
the detached Object/Element Complex. 

 

Note: If two face identical segments are found, the algorithm transfers these lines in upper and bottom 

breaking edge. All other lines are moved in the layer “General roof line”. 

If several closed polygons are found, several new objects/elements are generated in the same step. Thus all 
dormers of a roof can be detached in one step. 

Detaching complexes is done with the following workflow: 

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Active Complex (cf. 2.7). 

3. Select Line Editing Mode  (cf. 2.9). 
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4. Click at Create new complexes (cf. 1.7.2).  A detaching wizard consisting of three steps is 
started. 

5. Step 1: Define which lines the automatic algorithm shall search: 

a. Which lines 
The automatic candidate search can be restricted to previously 
interactively selected line segments or to all lines of selected 
layers. 

 

Note: If “Search in interactively selected” lines is 

selected, all selected line segments that are not part of 

any and that are not inside any closed candidate 

polygon are put into a separate candidate. After 

detaching that candidate, the user must interactively 

correct the lines (e.g. create a closed outer boundary, 

etc) before the triangulation algorithm will work. In order 

to avoid that work we recommend preparing a closed 

polygon in advance so that the automatic algorithm can 

find candidates with closed outlines. 

b. Maximum Segment Count 
defines the maximum number of polyline segments that define a candidate closed polygon. If a longer 
closed polygon needs to be found, this number can be increased (which will also increase the time 
needed for searching candidates). 

 

Advice: You may start a first search with default settings. If the polygon was not found, go back one 

step in the wizard, increase this value, and try again. 

c. Selection Mode  
defines whether the automatic candidate search shall look for smallest possible polygons or for 
largest polygons (regarding the area defined by the polygon). 

 

Example: The following image shows the result depending on the adjusted method of choice. On 

the left lies the initial situation, in the middle the found candidate for the search for the largest 

polygon and on the right side the result for the search for the smallest polygon. In the right case 

two candidates cannot be found since every segment is assigned to one candidate only once. The 

residual segments (black) do not form a self-contained polygon anymore and are not indicated as 

a potential candidate. They remain at the initial layer. The black line in the middle case (Ridge Line) 

completely lies within a candidate polygon and will therefore be adjusted to a General Roof Line 

during detachment. 

 
6. Step 2: Check the candidates found:  

The candidates are shown graphically. 
• Number of polygons found 

• The number of candidates to be detached is displayed.  

• Navigation 
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• The arrow-buttons allow for navigation through the list of 

candidates and activating any of the candidates. The button  
allows for activating one of the candidates by clicking at it in the 
viewport. 

• Reduced View in Viewport 

• If checked, all other lines/faces of the active complex are invisible 
in order to clearly show the candidates. If the checkbox is 
deactivated, the other lines/faces are shown, too, which may be 
helpful for orientation. 

7. Exclude those candidates that shall not be detached 

Active Selection 

One of candidates is the active one (its index in the list of candidates is written in the field “Active 
Selection”). It is highlighted. This one can be deleted from the candidate list via the button Exclude 
(don’t press the DEL-key, because that would delete all lines of the candidate!) As soon as only these 

candidates remain which need to be detached, click .  

8. Step 3: The remaining candidates can be detached as: 

a. Detail Element Complexes of the current main Element 
Complex. 

b. New Main Element Complexes in the current Object. 

All candidates which are detached as a Detail Element Complex or 
Element Complex, can be given a name which can be optionally typed 
in the given description field or is acquired from the name of the 
source layer. 

 

Note: In order to derive the naming of (Detail) Element 

Complexes from a layer, it is recommended to consider a 

division into layers when starting a data evaluation and 

to use these user-defined layers when converting the 

data into CityGRID® format. By doing so it is possible to 

lay various dormers onto a corresponding layer “dormer” 

by the photogrammetric operator and to include the layer 

“dormer” into CityGRID® when conversing. When 

detaching the lines on this layer, the name can be taken 

over and can be assigned to the candidate. 

c. New Objects 

Use the pull down menu to define the Object Class for new Objects. These object classes are 
currently available: 

• Building 

• Cut-out object 

• Underground Building 

Objects can also have ObjectIDs assigned. If more than one Object is detached all Objects will 
get the same ObjectID assigned. 

d. New Units. The UnitID of the new Unit can be given.  

 

Note: If there is more than one candidate, one new Unit with several separate Element Complexes 

is created in the new Unit. 

9. Click at  to end the wizard. 

10. Click at Triangulate/Apply changes  (cf. 1.7.2) in order to let the new Objects/Elements 
derive faces.  
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Note: If candidates were derived from interactively selected lines and one of the detached candidates or the 

remaining Element does not have a closed polygon, the Modeler will ask, whether he shall close the outline 

automatically. If the outline consists of more than one part, this is not possible. In that case, the user is 

responsible for closing the outline 

5.3.1. Modelling a Passage/Overbuilt Object  

Passages or other overbuilt areas (arcade passageways) can be modelled by means of Cut-out Objects. The "air 
space" is modelled as object with "roof lines". 

1. Digitize the outline (“eave line“) of the Cut-out Object as a polygon in an arbitrary layer of the main object 
(cf. 3.3.4). Pay attention on snapping exactly to the facade line of the main object at entrances. 

 

Advice: If the facade has already been provided with a texture, the drive can be elegantly digitalized with the 

setting “Snap to Face” (cf. Autodesk 3D Studio Max Help) in the textured 3D view. 

2. Detach object as new cut-out object (cf. 5.3).  

3. Click at Triangulate/Apply changes  (cf. 1.7.2) 

5.4. Binding Complexes 

On buildings with a multilevel hierarchy, the most common complex type is usually the Detail Element Complex. 
Complexes of this type feature an intact parent-child relationship and are also handled as such when generating 
faces (cf. 2.8.5). 

Due to the definition of the line framework in CityGRID®, the building semantics can be correctly described as 
attributive, but geometrically they are two totally independent complexes, and the other complex is not updated 
automatically if any geometric changes are made to one complex. To create the binding for a parent-child complex, 
you need to transfer the line framework of the child complex and automatically derive the determining extrusion 
directions (cf. 2.8.5).  

Here, every part which has no intersection point with the face of the parent element is extracted from the layer of 
the Outer Boundary Polygon. CityGRID® extracts one point from each of the parent faces in the sections, if 
necessary the (secondary) extrusion direction in which the faces of the child complex (e.g. roof) must be extruded, 
in order to guarantee a precise clip with the faces of the parent element. Ultimately, a complete face net is formed 
in combination with the unchanged primary extrusion direction. 

The result of binding Detail Element Complexes to their associated Main Element Complex is a precisely 
intersected face framework of the Detail Element Complex, which updates geometric changes to the face net of 
the parent complex and always creates correct intersection situations. The basic line framework of the Detail 
Element is reduced to the necessary line segments and changed to such an extent that the basic properties of a 
CityGRID® dataset are no longer valid. 

Right-click the Hierarchy Dialog to find the option Bind Detail to Main Element Complex to bind a detail element 
complex to the parent complex. All convertible structures in the selected complex plane are detected by the action 
automatically and handled accordingly. 

 

Tip: Use the Threshold for Detail Binding parameter in the Options menu (cf. 2.5) to define the tolerance for 

intersection points between roof faces and boundary polygons. 

 

Tip: If the action is started at the model vertex, the entire dataset is converted. If the action is started at the 

Unit vertex, all the details in this Unit are converted, etc. 

 

Note: After the line framework is converted, the editing options are restricted. If complexes can’t be 

transferred to the binding concept, they remain in the previously valid CityGRID® data structure. 
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5.5. Delete Complexes  

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Object or Element Complex to be deleted as Active Complex (cf. 2.7). 

3. Select delete active complex in the right-click menu of the Hierarchy Dialog. Confirm control question 
with OK in order to initiate deletion process. 

 

Note: For opening this menu without changing the Active Complex, you need to click into the lower 

free space or the border of the Hierarchy Dialog 

4. Confirm warnings if shown1 

5. Click at Triangulate/Apply changes  in order to take over the changes. (cf. 1.7.5) 

As an alternative to the right-click menu the active complex can be dragged via drag & drop into the recycle bin 
. Steps 1-2 and 4-5 do not change. 

 

 

Advice: If the active complex is clicked and dragged, the selected complex appears half-transparently at the 

mouse position. If the wrong complex has been selected, the drag & drop process can be cancelled by letting 

the selected complex drop outside the hierarchy window. 

 

Note: The Active Complex is deleted together with all the complexes of lower hierarchy level belonging to the 

active complex. 

 
Example: If you want to delete an Object, it is deleted together with all of its Element Complexes and their 

Detail Element Complexes. 
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5.6. Tear down the entire Unit  

1. Check out the Unit  (cf. 2.6.1). 

2. Select the Unit to be torn down as the Active Complex (cf. 2.7). 

 

Note: For opening this menu without changing the Active Complex, you need to click into the lower free space 

or the border of the Hierarchy Dialog. 

3. Select delete active complex in the right-click menu of the Hierarchy Dialog. 

4. Confirm the question whether you really want to delete by clicking at . 

 

Note: In the database version of the Modeler, Units are not deleted, but all objects of the current (checked-

out) version of the Unit are deleted. The status the Unit is changed from "Checked out" to "Torn down". Thus 

the last valid version has no geometry any more. However, the Unit with its version history remains further 

accessible. Older versions of the Unit can thus be loaded again.1 

In the file based version of the Modeler, the Unit is removed from the file, because there is no version control. 

5.7. Show and Load Torn Down Units  

1. The Selection Polygons of torn down Units are usually not 
displayed. In order to be able to access torn off Units, first 
their Selection Polygons must be displayed: Click 
CGModeler> Show Torn-down Units to activate the 
display  

 

Note: The colour of the Selection Objects of 

torn down Units (by default: black) can be 

chosen in the Options Menu (cf. 2.4.4) 

2. After clicking on the menu entry Edit Torn-down Units 
the Selection Polygon of a torn down Unit can be selected 
graphically which opens the Version History Window of 
that Unit. The last version has the state “torn down”. 

3. As described in section 2.6.4 an older version of the Unit 
can now be loaded. 

5.8. Move Complexes in the Hierarchy Dialog  

5.8.1. General notes to drag & drop 

• In the Hierarchy Dialog, any Complex (Unit, Object, Main Element Complex, Element or Detail Element 
Complex, cf. Manual CityGRID® Basics) can be selected with the left mouse button (Standard drag & 
drop), dragged to another Complex and dropped there, if the dragged and the target complex are part 
of checked-out Units. During dragging, the mouse symbol indicates whether it is a valid action. 

• If a layer is dragged via drag & drop, next to the standard drag & drop there is a drag & drop procedure 
available carried out with the right mouse button. Using the last option a context menu is faded in at 
the target point of the mouse movement in which the procedural mode of the dragged layer can be 
precisely indicated. Depending on the layer various entries can possibly appear in this context menu. 
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• By default the drag process of layers takes place within the same unit, i.e. the selection or the whole 
layer is moved to the new target and will be deleted in this original location. For drag & drop extending 
the unit the copy process is carried out, i.e. layer and selection will remain at the original position. 

 

Advice: Keep the CTRL-button pressed in order to switch between copy and move. The contrary 

action is always executed by default. 

• If layers or selection are moved to other elements via drag & drop, there is always the process of adding 
the moved line structures to existing ones. 

 

Advice: Keep the Shift-button pressed in order to switch between the actions “add“ and 

“replace“.  

 

Note: Especially at the layers Outer Polygon: Eave and Upper Facade Polygon and/or Lower 

Facade Polygon and Outer Floor Boundary it has to be noted on part of the Modeler that only 

one 3D polyline exists. Since these layers are in a special relation, lines which are 

moved/copied onto one of these layers are automatically transferred. If this performance is not 

demanded, the Master-Slave relation can be temporarily cancelled in the layer window. (cf. 

2.9.1) 

• Depending on the hierarchy level of the complex to which the dragged complex is dropped, a new 
complex of one hierarchy level lower is created there. If the dragged complex is dropped over: 

❖ the Model, a new Unit is created, 

❖ a Unit, a new Object is added to the Unit, 

❖ an Object, a new main Element Complex is added, 

❖ a main Element Complex, a new Detail Element Complex is added, 

❖ a Detail Element Complex, the action is invalid. 

• The dragged complex is removed from the complex to which it belonged to. If afterwards 

❖ remains an Object without Element Complexes, the Object is deleted, 

❖ remains a Unit without Objects, the entire Unit will be removed. In the database version of the 
Modeler the Unit will be torn down (cf. 5.6). In the file based version, the Unit will be removed 
from the file. 

• By clicking Triangulate/Apply changes  after Drag & Drop operations in order to take 
over the changes, all Units concerned are triangulated automatically. (cf. 1.7.5) 

 

5.8.2. Merge Multiple Units to one Unit with Multiple Objects  

This task typically needs be done after the import of a CAD 
file. The main buildings have to be merged with auxiliary 
buildings to one Unit. 

1. Load all buildings  which are to be merged to 
one Unit (cf. 2.2.3). 

2. Check out all Units concerned  (cf. 2.6.1). 

3. In the Hierarchy Dialog, move the Unit to the 
target Unit with drag & drop (cf. 5.8). All Objects 
of the old Unit are added to the target Unit and 
the old Unit disappears from the Hierarchy 
Dialog. 

4. Repeat step 3 for all Units to be merged with the 
target Unit. 
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5. Click at Triangulate/Apply changes  to take over the changes (cf. 1.7.5). All Units 
concerned are triangulated. 

6. Click at Save  (cf. 1.7.5). A status bar appears listing the most recent modifications at the units.  

The unit that has been moved will always be indicated with the status „Delete“; the one which was moved to has 
the status “Update“. If you press Yes in the status window, all affected units will be saved. 

5.8.3. Move an Object to another Unit  

1. Load all buildings  which are to be merged to one Unit (cf. 2.2.3). 

2. Check out both Units concerned  (cf. 2.6.1). 

3. In the Hierarchy Dialog, move the Object to the target Unit with drag & drop (cf. 5.8).  

4. Click at Triangulate/Apply changes  to take over the changes (cf. 1.7.5). All Units 
concerned are triangulated. 

5. Click at Save  (cf. 1.7.5). All Units concerned are saved. 

5.8.4. Detach an Object to a separate Unit  

1. Load and Check out the Unit  (cf. 2.6.1). 

2. In the Hierarchy Dialog, move the Object to the hierarchy level Unit with drag & drop (cf. 5.8). A new Unit 
is created with a suggested UnitID starting with "autogen". 

3. Click at Triangulate/Apply changes  to take over the changes (cf. 1.7.5). All Units 
concerned are triangulated. 

4. Click at Save  (cf. 1.7.5). All Units concerned are saved. 

 

Note: We recommend assigning a UnitID to the newly created Unit immediately (cf. 2.8.2) 

5.9. Penetration Analysis 

CityGRID® derives faces by default from the line structure of the building models (see. Manual CityGRID® Basics). 
Depending on the accuracy of restitution buildings can thus overlap and form surfaces inside of another structural 
body. To remove these commonly unwanted faces, Penetration Analysis is available. It is an extension of the 
triangulation algorithm, for detection and removal of interior face sections. Penetration analysis affects element 
complexes, the face generation options of surface manipulation (see. Manual CityGRID® Basics) can be adjusted 
individually. 

5.9.1. Options of Penetration Analysis for active Unit 

1. Load and Check out the Unit  (cf. 2.6.1). 

2. In hierarchy window click any complex (Unit - Element) with right mouse button to bring up the context 
menu. 

3. Select Face manipulation options. 

4. Check desired options in upcoming window and confirm by clicking . 
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Note: See Manual CityGRID® Basics for explanation of available face generation options together 

with sample figures. 

5. Click at Triangulate/Apply changes  to take over the changes (cf. 1.7.5). All Units 
concerned are triangulated. 

6. Click at Save  (cf. 1.7.5). All Units concerned are saved. 

5.9.2. Options of Penetration Analysis for multiple Units 

1. Load region  (cf. 2.2.3). 

2. In hierarchy window right click each Unit and chose Distinguished from context menu (cf. 2.7.3). 

3. In hierarchy window right click to open context menu and select All distinguished complexes > Check 
out if units are loaded from database. 

4. In hierarchy window right click to open context menu and select All distinguished complexes > Face 
manipulation options. 

5. Check desired options in upcoming window and confirm by clicking . 

 

Advice: By clicking on column header respective option for all units can be set. 

 

Note: See Manual CityGRID® Basics for explanation of available face generation options together 

with sample figures. 
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6. Click at Triangulate/Apply changes  to take over the changes (cf. 1.7.5). All Units 
concerned are triangulated. 

7. Click at Save  (cf. 1.7.5). All Units concerned are saved. 

8. In hierarchy window right click to open context menu and select All distinguished complexes > Check 
in if units are loaded from database. 
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6. Operations with Models 

Models are logical groupings of arbitrary numbers of Units. Looking from the other way round, a Unit can be 
contained in an arbitrary number of Models.  

For the database version of Modeler, changing which Models a Unit is assigned has no impact on the Unit itself! 
Thus removing Units from a Model does not delete the Unit from the database. However in the XML Version of 
CityGRID®, deleting a Unit in Modeler will delete the data in the XML File. Each Model can be assigned a terrain 
model, roof texture image(s) and terrain texture image(s). 

Models are usually already generated during the import of XML data. Additionally a part of an existing Model can be 
declared to a new model at any time. Models can easily be deleted again. 

 

Note: There is always a Model with the name "DEFAULT", which contains all Units of the data base. If for 

some reason Units are not contained in the Default Model, you can add all missing Units using the menu 

„CGModeler – Synchronize ‘Default’ Model“. 

The following steps are permitted only if the Working Set was chosen by a Model (cf. 2.1.3). 

6.1. Creation and maintenance of Models 

Operations with models are only available in the database version of the Modeler. 

6.1.1. Create a new Model from existing Units 

1. Load all Units which are to be grouped to a Model  (cf. 2.2.3). 

2. Open the Model Properties Window (cf. 2.8.1). 

3. Type in a new Name of the new Model. 

4. If necessary, change further Model Properties (cf. the following 
sections). 

5. Click at . The new Model is created directly in the database. 

6. Finally you can select whether the new model shall be made to the 
new Working Set. 

7. If necessary, load the new created model by confirming with Yes. 

 

Note: In some cases it is necessary use the DEFAULT model to create a new model. Due to the fact that 

the DEFAULT model is not a working model and therefore cannot be selected in the model selection 

windows, it must be built separately in the Menu CGModeler -> Load Default Model. Depending on amount 

of the stored data loading of the DEFAULT model can take a fairly long time 

6.1.2. Establish model from Selection Polygons 

1. Open the Model Properties Window (cf. 2.8.1) 

2. Click the button Model Administration.  

3. In the graphic windows the selected Selection 
Polygons are shown. Select these units which 
should be summed up to a new model. 
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Advice: By dragging a Selection rectangular more units can be selected at once. Via the CTRL key 

units can be added for a selection, via ALT-key they can be removed from the selection. 

4. Under Name indicate the name of the model to be created. 

5. Click  

6. Specify the settings of the model in the status bar. 

Yes: Create models from loaded units.  

No: Create models from the selected polygons. 

7. If necessary, re-load the created model by answering the control question with a Yes. 

6.1.3. Establish model from UnitID 

1. Open the Model Properties Window (cf. 2.8.1) 

2. Click the button Model Administration.  

3. Click Select by Name  in main button bar of 3D Studio. 

4. Press button Shapes  in row „Display“, in case it is not activated (highlighted in orange). 

5. In the window all selection polygons of 
the currently loaded model are 
displayed by their name. The name of 
each selection polygon is constructed 
as follows: DBUnit_NB: Unit name. By 
selecting the desired Units by mouse 
click on the corresponding name (hold 
SHIFT to select multiple names or CTRL 
to individually add names to selection) 
or by entering a text string in the field 
“Find”. 

 

Advice: If the names of Units 

which should be composed to 

a model are known, this 

model can be created 

efficiently by using so called 

wildcarding the text field 

“Find”. Use * as wildcard in 

3D Studio. For example 

entering “*9.03” selects all 

selection polygons with the 

string 9.03 somewhere in 

their name. 

6. Confirm selection by clicking . 

7. Under Name indicate the name of the model to 
be created. 

8. Click  

9. Specify the settings of the model in status bar. 

Yes: Create models from loaded units.  

No: Create models from the selected 
polygons. 
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10. If necessary, re-load the created model by answering the control question with a Yes. 

6.1.4. Add Unit(s) to a Model 

Adding Unit(s) to an existing Model is done in the same way as creating a new 
Model. Execute all steps of section 6.1.2. In step 3, type the name of the 
existing Model. After clicking at Create, the message appears that the Model 
already exists. 

Confirm the question with Yes in order to add the Unit(s) to the existing Model. 

6.1.5. Remove Unit(s) from a Model 

Removing a Unit from a Model removes only the containment relation between 
Unit and Model, but does not have any effect on the appearance of the Unit in 
the database. 

There are two alternatives to remove Units from a Model: 

Remove multiple Units: 

1. Open the Model Properties Window (cf. 2.8.1) 

2. Click the button Model Administration.  

3. In the viewports, only the Selection Polygons are shown. Select those 
Units that shall be removed from the Model and delete them (e.g. with 
the DEL-key). 

4. Click at Update. Those Units for which the Selection Polygon was 
deleted will be removed from the Model (directly in the data source). 
The Units themselves will remain in the database at least in the Model 
‘DEFAULT’. 

Remove a single Unit: 

1. Open the Hierarchy dialog (cf. 2.7.1) and select the Unit you want to remove with the right mouse button. 

2. In the context menu select Remove Unit from Model. 

6.1.6. Change the Name of a Model 

3. Open the Model Properties Window (cf. 2.8.1). 

4. Type in a new name. 

5. Click at . The new name will be saved directly in the data source. 

6.2. Assign a New Terrain Model 

1. Open the Model Properties Window (cf. 2.8.1). 

2. Click at the button  beside Terrain. A selection window with all terrain models available in the data 
source is opened. 

3. Select the desired terrain model. 

4. Click at . The selection window is closed. 

5. Click at in order to save the new assignment in the data source. 

From that time, the new terrain model will be used in the face generation process when the facades of Units are 
extruded.  
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A terrain model in the database can be assigned to any number of Models. 

 

Advice: In order to adapt all Units of the Model to the new terrain model without having to check out and 

triangulate each Unit individually, continue in the following section. 

 

Note: Several terrain models can be assigned to one model. Each terrain has to be added in the way 

mentioned above. It is recommended not to assign overlapping terrain models since it cannot be predicted 

which terrain will be used (e.g. at extrusions of facades). 

 

Note: If the database holds more than one version of a terrain model, the latest version will be assigned 

to the model. 

6.3. Delete a Model 

Deleting Models is available only in the database version of the Modeler.  

Models can be deleted again any time (exception: the model "DEFAULT"). 
The Units remain untouched in the data base. Only the relation to the  
model is deleted. 

1. Select the Model to be deleted as Working Set (cf. 2.1.3). 

2. Open the Model Properties Window (cf. 2.8.1). 

3. Click at . 

4. Confirm the question whether you really want to delete the Model. 
The Model will be deleted from the database. Afterwards, the Working 
Set Window is opened to select a new Working Set. 

 

Note: If a corrupt Model exists in the database, it will be deleted 

automatically after a failure of loading it. 

6.4. Assign Texture Images to a Model  

1. Open the Model Properties Window (cf. 2.8.1). 

2. Click at the button  beside Textures. A selection window with the names of all images available in the 
data source is opened. 

3. In the lowest line of the selection window a filter can be given: all images, all ortho-images or all images 
with perspective projection. 

4. Select the desired image. 

5. Click at . The selection window is closed. 

6. Activate the corresponding checkboxes for Area and/or Terrain to specify the usage of the image. 

7. Click at in order to save the new assignment of the texture image to the Model in the data 
source. 

 

Advice: Use standard Windows functions for multi selection in selection window. 

To texture a terrain with multiple images, it is necessary that the image boundary coincide with adequate edges of 
the TIN. It must be clear that a triangle of the TIN needs to be fully covered by one texture image, otherwise this 
triangle can’t be textured. We recommend using orthophotos for terrain texturing. The boundaries of a set of 
orthophotos usually define a regular grid. CityGRID® Administrator provides a tool for intersecting a regular grid 
structure with a TIN. This makes sure, that a series of orthophotos can be used for terrain texturing (cf. Manual 
CityGRID® Administrator) 
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An image in the database can be assigned to any number of Models as texture image. 

Deleting a texture image assignment can be done by selecting the image name in the list of texture images and by 

clicking at the button  right of the list. The assignment of that image to the Model is removed, but the image 
remains in the database. 

 

Advice: For texturing roofs the original aerial photographs with their perspective orientation parameters are 

suitable. Using these parameters each roof triangle can be projected into the image and texture coordinates 

can be determined. Orthophotos are in general not suitable, since these were usually produced using the 

terrain model and therefore have displaced roofs (except true orthophotos). 

For texturing the terrain we recommend a map or a True Orthophoto. Normal orthophotos often show displaced 
buildings in the area of the road. You get the same effects, if the perspective aerial photograph is used directly. 

The terrain texture is always calculated online and need not be pre-calculated. 

 

Advice: In order to adapt all Roof Textures of the Units of the Model to the new texture image without having 

to check out and edit each Unit individually, continue in the following section. 
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7. Attribute Management 

7.1. Attribute Table 

Besides building semantics and geometry attributes can also be managed with CityGRID®. These attributes can be 
assigned to each hierarchical level. In order to set and inspect the attributes an attribute table can be opened, from 
the CityGRID® Administrator and CityGRID® Modeler (see manual CityGRID® Modeler). 

Attributes can be assigned to each CityGRID® complex type. Unit attributes are version-independent and act on all 
existing versions of the unit (see. 2.6). Object, Element Complex, and Element attributes, are depending on the 
version. Existing attributes are inherited automatically during check out of a unit. 

 

Note: Each attribute change, except for the model attributes must be confirmed by Triangulate / 

Apply Changes  (see. 1.7.5). For model attributes a window directly comes up when closing the 

attribute table to save pending changes. 

Via attribute table attributes can be set, inspected, altered and deleted. New attribute columns can also be created 
and existing deleted. Depending on hierarchy level displayed content of attribute table may vary, but basic 
functionality remains always the same. 

 
The attribute list is made up of the following components: 

• Complex type:  

Shows type of selected hierarchy level. All known CityGRID® Complex classes (Unit to Detail Element 
Complex) are available. 

 

Note: By right-clicking on Complex type column header, the display of different complex types is found 

in the context menu under visibility. 

• Name: 

 Specifies the UnitID of the respective complex. This attribute is present in each complex type. 

• Id:  

Is a serial number that identifies the list items of the attribute table with a unique ID. The ID is assigned at 
runtime and is not related to existing attributes. 

All other columns are optional and represent the actually occurring attributes per complex type. If complex types 
have different attributes and are displayed together, the attribute table always shows the totality (union) of all 
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existing attributes. If a complex type doesn't have a particular attribute set, the corresponding record will appear 
empty in attribute table. At save only set attributes are written. 

Click  to confirm, or  to discard changes. 

 

Note: For automated filling of attributes from external data the FME CityGRID® Writer can be used. In order to 

develop a customized solution, please contact your advisor at UVM Systems contact. 

7.2. Open Attribute Table 

The attribute table is accessed via the right-click menu of the hierarchy window and appears as a floating window 
that is placed over the viewport of the Modeler. Size and position of the window can be set by the user individually. 

 

Note: Model and Unit attributes can also be edited in CityGRID® Administrator (see manual CityGRID® 

Administrator). Especially for Unit attributes it is more advantageous than the processing in Modeler because 

check out of Units can be omitted.. 

7.2.1. Open Attribute Table for active Complex 

1. Load and Check out the Unit  (cf. 2.6.1). 

2. Select active Complex (cf. 2.7.2). 

3. Click the active complex with the right mouse button in the hierarchy window and from the context menu 
select the entry Attribute-Table. 

7.2.2. Open Attribute Table for multiple Complexes 

1. Load all desired Units (cf. 2.2) 

2. Distinguish all need Complexes in hierarchy window. (cf. 2.7.3)  

 

Advice: In order to distinguish all units or objects of the loaded selection, feature Select distinguished 

complexes by attributes  (cf. 2.7.3.) can be used.  

3. In hierarchy window right-click and select All distinguished complexes > Check Out. (Only needed at 
working with databases) 

4. In hierarchy window right-click and select All distinguished complexes > Attribute-table. 

 

Note: 3.The attribute table opens only in the edit mode, if all distinguished complexes are checked out. (cf. 

2.6.1) If at least a checked in complex is found, the attribute table opens in a viewing mode that does not 

allow changes. Run check out for all distinguished complexes before you open the attribute table in edit mode. 

7.3. Editing Attribute Table 

7.3.1.  Create new attribute column 

1. Open Attribute Table (cf. 7.2) 

2. Right-click an existing column header (e. g. ID) in attribute table and select New Column. 
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3. Define Column name and data class in Attribute Details window. 
Available classes:  

4. String: arbitrary text strings 

5. Date: Date in all common spellings 

6. Double: Point numbers, the number of decimal places can be defined 
under Accuracy. 

7. Integer: integer values 

8. Boolean: True (1) / False (0) 

9. List: Attribute, which in turn contains a list of the attributes listed 
above. 

Define Units of Measure (UOM) for all numeric attributes. 

Specify Value at column definition if applicable. This value will spread over all selected list entries. 

10. Click  for creation of column, or  to discard changes. 

 

Note: In attribute table, each column name is unique, the upper / lower case must therefore be 

observed. The reapplication of an attribute of the same name is not admissible. 

If multiple attributes of the same name must be created (eg. externalRefernces in CityGML) this 

can be done only via FME. When reading such attributes into attribute table CityGRID® converts 

these attributes into a simulated list attribute and cares for correct reconversion at saving. The 

lists behave like ordinary attributes list, and can also be changed in the values. By changing the 

column names separate list attributes will be created instead. Returning to the initial state is no 

longer possible in this case.. 

11. Click at Triangulate/Apply changes  to take over the changes (cf. 1.7.5). All Units 
concerned are triangulated. 

12. Click at Save  (cf. 1.7.5). All Units concerned are saved. 

7.3.2. Modify existing attribute column 

1. Open Attribute Table (cf. 7.2) 

2. Right Click an existing column header, with the exception of complex 
type, name and ID, in the attribute table and select edit. 

3. Apply changes. 

 

Note: Changes to the data class are allowed only if 

existing values don’t interfere with new data class. If 

conversion to the desired class is not possible, a message 

appears showing name and the affected value, separated 

by "." (point) (eg. Unit_1.hallo). The first 20 problem cases 

are listed. 

4. Click  for creation of column, or  to discard changes. 

5. Click at Triangulate/Apply changes  to take over the changes (cf. 1.7.5). All Units 
concerned are triangulated. 

6. Click at Save  (cf. 1.7.5). All Units concerned are saved. 

7.3.3. Delete existing attribut column 

1. Open Attribute Table (cf. 7.2) 

2. Right Click an existing column header, with the exception of complex type, name and ID, in the attribute 
table and select delete column. 
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3. Click  for creation of column, or  to discard changes. 

4. Click at Triangulate/Apply changes  to take over the changes (cf. 1.7.5). All Units 
concerned are triangulated. 

5. Click at Save  (cf. 1.7.5). All Units concerned are saved. 

7.3.4. Select (and modify) column entries 

1. Open Attribute Table (cf. 7.2) 

2. Right Click an existing column header, with the exception of complex type, name and ID, in the attribute 
table and chose select column. All fields of the column are selected by this action. 

3. Now right click any selected cell and select edit to change the value of the cells, or delete to remove the 
values. 

4. Click  for creation of values, or  to discard changes. 

 

Advice: Cells can be selected / deselected via standard Windows mechanisms. 

7.3.5. Sorting columns 

1. Open Attribute Table (cf. 7.2) 

2. Left click an existing column header. A small triangle is showing up, indicating that sorting is based upon 
this column now. Displays the tip upwards there is a rising order. Clicking again on the same column 
header will change the sort order to descending order. 
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8. Texture  

CityGRID® offers two possibilities for the process of texturizing: 

• semi-automatically via oriented image files 

• interactively via freely-taken picture 

The (semi-)automatic process of texturizing requires the import of oriented image files into the data source 
including additional assignment to the working model; the texturizing process can run automatically subsequently 
for all units of a model or only for parts of the same. 

The process of interactive texturizing takes place on the element in CityGRID®, unit per unit. Carrier of the texture 
information is the face and not the structure line of a building like at the modelling process. It is not of relevance 
which element the face belongs to so that every face in CityGRID® can also carry a proper texture. 

8.1.  Interactive texturizing  

1. Load and Check out the Unit  (cf. 2.6.1). 

2. Check Textures in Display section of Main window to display textures in Viewport (cf. 2.4.2).  

3. Select the Active Complex (cf. 2.7). 

4. Choose the face layer of the active complex (cf. 2.9.1) 

5. Select polygon selection  (cf. 2.9.1). 

6. Select the faces to be textured in the preview window. The polygon selection automatically selects all 
related faces with equally adjusted face normal and those for whom the threshold for coplanar faces is 
within range. 

 

Advice: In order to add faces to a selection, keep the CTRL button pressed while clicking. To deselect faces 

keep the Alt-button pressed. 

7. Click at Load Material  (cf. 1.7.3) 

The properties window opens in which the material to be mapped has 
to be defined. The material describes how a 3D object performs under 
the influence of light. 

Firstly, the material source needs to be defined:  

• Create new material 

A new material without colour, transparency and image information 
is created. It is used in the case when a material not yet existing in 
the scene needs to be created.  

• Use previously created:  

Uses material that was created at last call of Create new material. 
Usable for faces with identical or similar image data. 

• Take from selected face:  

Serves to re-load material already mapped from a face into the texture window. 

• Derive automatically from model: 

If oriented images are assigned to the model and the selected faces are existing in the image, the 
selected face is mapped semi-automatically with the material. (cf. 6.22). 

• Get from image server: 

Establishes a connection to a mobile mapping images server for semi-automatic texturing.  
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Material data determine appearance of the material source defined before. 

• Use texture image:  

If (default setting) activated, the material uses the texture image. It can be loaded via  button. As 
soon as an image is loaded, the filename appears in the adjacent description field. Via buttons 

 the previous/next image can be determined as Texture Image. 

 

Note: All common graphic formats are supported. However, jpg2000 format is not supported in 

this CityGRID® version. 

• Use colour/transparency:  

If no texture image should be assigned, instead, a uniform face colour can be assigned to the 
material. Fields for colour and transparency are activated if the checkbox is set. In order to modify 
the colour settings, you must click into the Colour Field. Consequently the colour mixer of Autodesk 
3D Studio Max opens. The value for transparency ranges from 0 (opaque) to 100 (transparent). 

 

Note: Texture Image and colour can be assigned to a material simultaneously; however, when 

maintaining the standard settings in Autodesk 3D Studio Max only the texture is displayed. A 

coloured mixture (multiplication) of colour and texture image does not take place. Transparency 

and texture image are shown simultaneously, though. 

8. Click  in order to resume the material settings. 

Depending on the settings the selected faces are mapped with colour/transparency, semi-automatic 
texturizing processes are carried out or the chosen texture image is loaded into the texture window for 
further editing. 

9. Geometry and texture are now combined in the texture window. After the faces to be textured have been 
marked in advance and the according texture image has been specified, the image and the mesh of the 
selection are faded in the texture window. 

 

Advice: The line colour of the projected mesh as well as the background colour can be adapted in 

menu CGModeler-Edit User Defined Default colours (cf. 2.4.4) in Object Selection “Miscellaneous 

Module Colours“, Element Selection „Texture window“. Line thickness can be modified in the 

options dialog (cf. 1.7.1). Modifications become active when loading the material data into texture 

window afterwards. 

There are always four points of the mesh, which are taken as a basis for the calculation of the even 
equalization, marked by a square. These are the most external points (support points) which represent, in 
general, the vertices of a facade.  

For a successful texturizing process the mesh has to be covered with the situation in the image. This can 
be done by clicking any vertices of the mesh and dragging them to the corresponding position in the image. 
Dragging an anchor vertex causes the adjustment of all spare points of the mesh, except the remaining 
anchor points. Use scale mode for simultaneously adjustment of all anchor points. 

If a marked point is selected, a drag or scaling cursor appears above the point, 
depending on the transformation mode selected (cf. 1.7.6). The x axis is always 
displayed in red and the y axis in green. In addition, a square (drag mode) or a triangle 
(scaling mode) are displayed between the axes. When you move the mouse across 
an axis or the square/triangle, the affected section is highlighted in yellow, and the 
mouse pointer changes its shape. If the axes are highlighted, the point can be 
dragged/scaled along them. If the square or triangle is highlighted in yellow, dragging takes place in the x 
and y directions, and scaling occurs in both directions. 

 

Tip: In order to activate a point, it is advisable to drag a small selection square around the point, 

instead of clicking on the point directly. 

In order to move several points at once, a selection rectangular can be created in the texture window by 
clicking and dragging it over the required area. Subsequently, the mouse pointer has to be clicked and 
dragger over a selected anchor point. The selection remains unchanged until one vertex outside the 
selection is clicked or a new selection rectangular is created. 
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By clicking the mouse wheel the cut-out of the texture window can be moved (Pan), scrolling the mouse 
wheel causes a magnification/diminution of the displayed cut-out (Zoom). The same actions can also be 
carried out via the buttons of the texture window. (cf. 1.7.6) 

 

Note: If facades are textured and a terrain has been assigned to the model, the Terrain Intersection 

Line in the facade face will be faded in. This line should be covered with the completion of the 

facade in order to gain best texturing results. The steeper the area is, the more bottom facade 

edges and Terrain Intersection Lines diverge, since the facades are always extruded to the deepest 

intersection point of the terrain model and the upper façade line, projected on the terrain. Parts of 

the facade are therefore located under the terrain. 

 
Example: a material with a texture image should be assigned to a facade face. The facade face 

was selected in the preview window via polygon selection, a material was created and the texture 

image was loaded into the texture window together with the mesh (a). Now the four external 

vertices are adapted to the image step-by-step. Starting with the left top corner (b) the geometry of 

the mesh changes with each additional adapted point (c – e). After having finished the adaptation 

(e) an ortho image (cf. below) will be calculated and applied to the facade faces. Subsequently, the 

mesh in the area of the round arch in the roof will be adapted to the image in a better way (f). 

 
Click the mouse wheel to shift the detail of the image view (pan). Scroll the mouse wheel to maximize / 
minimize the detail displayed (zoom). The same actions can be executed using the buttons on the image 
view (cf. 1.7.6). 

To change the selection of anchor points, select a non-anchor point and hold the left mouse button down 
above it. The point is then highlighted by a red circle and all four anchor points represent a green square. 
Use drag & drop to drag the clicked point to one of the four anchor points. When you release the mouse 
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button above the selected anchor point, the selected point adopts the status of an anchor point and the 
previous anchor point become a normal support point in the face net. 

 
Example: Let's assume you want to transfer an automatically selected anchor point to an adjacent 

support point. Drag the mouse pointer over Point 1 until a red circle surrounds it. Click and hold down 

the left mouse button and drag the point over Anchor Point 2 which is marked by a green square. 

When the mouse pointer is over Point 2, release the mouse button. The anchor point of Point 2 then 

assumes the status of Point 1. When you reselect the new Point 1, you can then use it to adjust the 

face net. 

 

10. Once the face net is adjusted to the image situation, click on Execute in the Texture Dialog  (cf. 1.7.6) 
to transfer the configuration setting in the Texture Dialog to the 3D model. In this step, the perspective 
view is distorted by the set anchor points in order to calculate an orthophoto. The orthophoto is also 
clipped to the size of the required image detail plus a buffer area and placed on the selected face of the 
3D model. 

 

Note: Four points are required to calculate an orthophoto using projective rectification. If only three 

face points are available, it is not possible to perform an orthophoto calculation. In this case, the 

texture process takes place by maintaining the perspective of the texture image. 

11. If necessary, you can execute even smaller corrections on the face net to adapt the image even better to 
the geometry (Texture Coordinate Mode). In Texture Coordinate Mode, all support points of the face net 
can be manipulated. Changes to the face net are now displayed in the preview window on the 3D model. 

Click on Restore Face Net By Orientation Parameters  (cf. 1.7.6) to restore the 
original state. 

12. Click the button Transform Using Anchor Points  (cf. 1.7.6) to return to the four highlighted 
anchor points and re-execute the orthophoto calculation, as described in Point 10 above. Click on 

Cancel  (cf. 1.7.6) in the restarted Anchor Mode to restore the result of the first orthophoto 
calculation in the Texture Dialog. 

 

Note: For calculating the projective rectification exactly four identical points are used. We 

recommend adjusting already these points accurately (step 9) although there is the possibility to 

correct them later (step 11). By correcting the points in step 11 only texture coordinates are 

changed, but a poorly transformed image is not corrected. Correctly transformed images can be 

needed in following applications (e.g. for the export to a GIS). 

13. Click Save  (cf. 1.7.5). By doing so the texture coordinates are saved and the texture image including 
image pyramid (in a database) are saved in the data source. 

8.1.1. Texturize long facades with multiple photos  

 

Note: Only faces of element façade can be split up. For façade elements with face generation type frozen 

face net (cf. 2.8.5) an automated split is not applicable. 

1. If textures have already been mapped, save first. Then execute steps 1 to 10 of the previous section in 
order to texturize a long facade section with the overview image. 

Subsequently, the facade can be divided into several tiles on recognizable vertical alignments. 
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2. Click on the button Break up the facade  (cf. 1.7.6) in texture window to start splitting mode. 

3. In the texture window a separation line can be set at any position (with the left mouse button). This 
digitized position will be drawn up vertically and a separation line (green) will be drawn into the mesh. By 
clicking and dragging the separation line it can be modified in the position. Dragging a line to the left or right 
margin of the texture window leads to the deletion of the separation line. 

 

Note: It is recommendable to set the separation points to recognizable vertical alignments (e.g. left bound 

of a window axis). 

4. Set as many additional division lines as demanded. 

5. By clicking the button Apply , the separation mode will be ended, the division of the selected faces 
into the amount of parts, which have been set before, will be started and applied texture is removed. By 

clicking Cancel , all changes are discarded.  

Now every single section with its proper detail image, as mentioned in the previous section, can be newly textured. 

 
Advice: To access the tiled facade sections switch from polygon selection  to face selection  

(cf.2.9) 90By doing so every single face triangle can be selected. 

When fitting (step 9) it has to be considered that the vertical triangular edge is concordant with the vertical 
alignment used at the division. 

8.1.2. Edit existing textures  

Execute steps 1 to 6 of section 8.1. By doing so, only select such segments which have been textured with the 
same texture image. 

7. Click Create Material  (cf. 1.7.3). 

Again, the properties window opens, in which the option Take from selected face has to be selected. 

In the texture window the image, which has already been assigned to the selection, is loaded and is 
displayed with the fitted mesh. Modification at the mesh are applied to the 3D model in the preview 
window in real-time. 

8. Clicking Restore Mesh  (cf. 1.7.6) rejects the modification at the mesh and restore the initial 
state.  

 

Note: After finishing correctional work, there is no need to recalculate the texture. 

9. Click Save  (cf. 1.7.5) 

8.2. Semi-automatic texturing from mobile mapping data  

In addition to the interactive texturing of handheld shooting, the connection to the image server of mobile mapping 
systems is another way to create high-resolution textures. The images are taken from street level and therefore 
suitable for texturing of facade surfaces. Roofs and structures on the roof on the other hand can’t be textured from 
mobile mapping data. 

1. Load and Check out the Unit  (cf. 2.6.1). 

2. Place a Check in the Textures in Display section of Main window to display textures in Viewport (cf. 2.4.2).  

3. Select the Active Complex (cf. 2.7). 

4. Choose the face layer of the active complex (cf. 2.9.1) 



 

  Manual CityGRID® Modeler – Page 91 

  

CityGRID  
         MODELER 

5. Select polygon selection  (cf. 2.9.1). 

6. Select the faces to be textured in viewport. The polygon selection automatically selects all related faces 
with equally adjusted face normal and those for whom the threshold for coplanar faces is within range. 

 

Advice: In order to add faces to a selection, keep the CTRL button pressed while clicking. To deselect faces 

keep the Alt-button pressed. 

7. Click at Load Material  (cf. 1.7.3) 

Choose Material source: 

• From image Server: The connection to a server with the geo-
referenced images is established. 

8. Click  to accept the material 
settings. 

Now, depending on the image server, a log in window appears, for 
specification of credentials (obtained from the mobile mapping 
company) and the EPSG code for the coordinate system appears. The 
connection to the image server is maintained throughout the CityGRID® 
Modeler session. 

In texture window you can see all eligible pictures for the selected 
facades after the transfer from the image server completed. 

 
In the thumbnails the candidate pictures are strung, as they are best from the viewing angle: the far left 
displays the currently applied recording with "0" and shown with a green background. To the right of "1" is 
the best, with "2" the second best, etc. 

 

Note: Ten shots are always requested from the server. If no suitable image can be found among 

the proposals, further recordings can be requested, as long as suitable images are available on 

Image Server. 

Images that are available on the image server, but which may not be accessed with the given 
credentials and, or can’t be loaded from the server show this symbol. If the image "0" icon 
shows the icon, the selected area bears currently no texture information. 

9. Now the best shot can be selected using the thumbnails. In texture window the selected area is displayed 
immediately, combined with the selected image. 

 

Advice: When choosing, make sure that any possible large obstructions such as trucks are in front 

of the facade. 
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10. With  the selection is confirmed and the selected facade elements are automatically textured. The 
result can be seen in the viewport immediately on the 3D model. 

 

11. Because of inaccuracies in the georeferencing of mobile mapping images or in the geometry of the building 
models, it minor errors in texturing result may occur. Such errors can be easily fixed in the texture window 
using the texture coordinate points (see. 8.1) 

 

Advice: Typically, the facade is mapped too narrow or too wide. In such cases, we recommend to 

select the left and right texture coordinate points and jointly adapting in the X direction. 

 

The adjustments using the texture coordinate points are immediately used for the texturing of the 

selected facade elements. 
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Other interactive texture adjustments are usually not required in mobile mapping situations, but 

all the functions described under 8.1 could be used in principle to revise the texturing. 

12. Click at Triangulate/Apply changes  to take over the changes (cf. 1.7.5).  

13. Click at Save  (cf. 1.7.5). Thereby the orientation parameters and the texture coordinates are saved 
and the texture pictures along with the image pyramid stored in the data source. 

8.3. Copy existing textures  

In general textures are unique for every face. However, there are complexes in a city model which can share 
identical texture images. For example, chimneys, columns and the like can be textured quickly by using a texture 
image repeatedly. Also buildings with recurring façade patterns can be – under certain circumstances – mapped 
using repeated texture images. 

 

Note: Only textures with known orientation values can be copied. 

 

Advice: Note when copying textures that no distinctive objects can be found in the image source (cars, 

trees, monuments, wall damages, etc.). The more homogenous the texture image to be copied is, the more 

inconspicuously it can be copied onto other parts of buildings. 

1. Check Textures in Display section of Main window for display of textures in Viewport (cf.2.4.2).  

2. In Layer Selection select face layer in Polygon Mode  (cf. 2.9.1). Depending on the selected Stamp 
Mode (see below) the selected element is either of importance or not. 

3. Click Copy Texture  (cf. 1.7.3) 

4. Define Stamp Mode, Scale Mode and Align Mode in properties 
window for optimal copy results. 

• Stamp Mode:  

Defines on which faces the copied texture will be mapped. The 
following methods are offered: 

o Picked faces:  

Texture will be copied by interactive selection of faces in 
viewport. As soon as the cursor hovers over a face, the 
mouse symbol changes to a crosshair as a hint for the user. 
Once you click a face, all triangles within the criteria of co-
planarity will be textured with the copied texture. 

o Picked element:  

Functions the same way as Picked faces, but copies the 
texture to the whole element  

 

Advice: Use this mode on equally textured objects such as columns or chimneys. 

o Only selected faces:  

If faces were selected prior to start of Copy Texture Tool in one element, only these faces 
will get the copied texture assigned. 

o All faces:  

Copies the texture to all faces of the active complex. No selection is needed in this stamp mode. 

o Whole texture (Element):  
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This is a special function for coping texture compilations (different images) from one element to 
another. To transfer the texture compilation a reference face from the source and target 
elements must be specified interactively. Using this reference face the orientation and 
transformation can be computed and the copied texture can therefore be placed smoothly. (see 
example copy texture on dormer windows) 

o Whole texture (Element Complex):  

Works the same way as Whole Texture (Element) with the difference being that all textures of 
the element complex will be transferred during copy (e.g. roof and façade texture of a dormer 
window) 

• Scale Mode:  

Defines how the copied texture will be mapped. The following methods are offered: 

o Unchanged:  

This parameter keeps all orientation parameters of the original texture image and doesn’t change 
the position of the image at texture mapping. 

 

Advice: Use this method if objects in front of already textured objects should be textured with 

the same image, e.g. oriels. 

o Relocate:  

Use this mode to adjust the position but not the scale factor, of the copied texture, based on the 
target. The orientation parameters will be adjusted to the new position in way, that the face 
normal of the to be textured face and the image aspect are continuous. 

 

Note: Both described functions can only be used successfully, if the image dimensions are 

big enough to cover the target faces. If a face to be textured exceeds the perimeters of the 

image dimensions of the source image, no image will be copied to that face; it remains 

untextured. 

To prevent such dimension differences between copied image and selected face, always use 

the largest found face(s) as source for texture coping (cf. 8.1) By doing so one can be sure 

that the image dimensions always exceeds the geometric perimeters of the faces to be 

textured. 

To see the image dimensions in viewport open menu CGModeler > Auxiliary Objects > 
Show auxiliary data of texture images. Around every texture image a thin grey border is 

drawn, representing the available image dimension. Click CGModeler > Auxiliary Objects 
> Delete Auxiliary Objects to hide the lines in viewport again. 

 

Advice: Use this mode to copy textures on shape related faces. 

 
Example: Image dimensions and potential target faces. 

The following figure shows the relation between image dimension of the source image, drawn 

as black rectangle, and target faces for texture copy. 

On the left dormer window the source texture is mapped which should be transferred to the 

other three dormer windows. On second and third (from left) dormer the texture can’t be 

copied in Scale Mode “Unchanged” and “Relocate” as the dimension in width (second) or 

height (third) exceeds the available image dimension and no scaling is applied at the selected 

Scale Mode. Only the right dormer has a face with smaller perimeters than the image 

dimension and therefore a valid situation for texture copy. The dormer window will get the 

image assigned. 
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o Scale: 

Functions the same way like Relocate but applies a scale factor to the source image, based on 
the shape of the target faces. The scale factor is derived by analysis of the largest change 
between source and target dimension. This value will function as global scale value for the whole 
texture. 

 

Advice: Use this method on faces with more or less related proportions to the source face to 

keep the scale factor in an acceptable region. 

• Align Mode: 

At Scale Mode “Relocate” and “Scale” the settings in this mode will decide where the insert point of 
the copied texture will be placed. Every combination from Top, Centre and Bottom as well as Left, 
Centre and Right can be specified. 

 

Advice: Benefit from Align Mode if regularly patterned textures (e. g. brick texture) should be 

copied and at the edges of two copied textures no mismatch should be visible 

 
Example: Results from copy texture with different Align Modes 

Left image shows the initial situation: One façade face of the roof detail is textured by a brick 

texture. This texture shall be copied to all faces of the chimney. 

Middle image shows the result under usage of Align Mode “Center Top”. A clearly visible 

mismatch between the mapped textures can be seen leading to an inconvenient result. 

Right image shows the result under usage of Align Model “Center”. The textures fit together 

smoothly at the edges and the result look homogeneous. 

 

5. After specifying parameters for coping a source image, it must be loaded in to stamp. Use the button under 
the section Stamp preview to select any desired texture in viewport. As soon as a texture has been 
selected a thumbnail image is drawn in the stamp button. 

 

Note: If no image is loaded into stamp, ”Empty Stamp“ is written in the stamp button. In case a 

face has been textured interactively (cf. 8.1) prior to use of Copy Texture Tool, the mapped 

texture image is used as stamp immediately. 

To exchange the image in stamp, simply re click the button and select any new texture in viewport. 

The previously loaded image will be removed from stamp. 
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6. Click button  to start coping texture based on the specified copy 
parameters. As long as the copy mode is active no new texture can be loaded into stamp. 

7. To finish copy mode re click  button. 

8. Click Copy Texture  (cf. 1.7.3) to close the copy tool. 

9. Click Save  (cf. 1.7.3) 

 

Note: Note when copying textures that the proportion of source and target faces are nearly the same.  

 
Example: Copy texture on dormer windows 

By using the stamp mode “Whole Texture“time for texturizing identical complexes can be reduced 

dramatically. Especially details on roofs (e. g. dormers) which often have the same appearance and are 

therefore most suitable for texture copying. Do as follows to transfer texture compilations from one dormer 

to another: 

Texture one element complex interactively (cf. 8.1 (suggested to start with the largest instance), as 

reference complex for copy texture (step a). Now start Copy Texture Tool, use “Whole Texture (Element 

Complex)” as Stamp Mode and “Relocate” as Scale Mode. Click the stamp button and load the image 

showing the window into stamp. This face can easily be identified in every other dormer and is therefore 

is the most suitable as a reference face. (Step b 1) Now click “Start copy” and select the front face of the 

next dormer. (Step b 2) The system now adjusts orientation parameters of the texture formation based on 

the selected reference face. If the faces of the target dormer are lying within the image dimensions all 

textures will be copied to the selected dormer. (Step c) Use the same procedure on all other dormer 

windows to transfer the texture. In each dormer the front face must be selected as reference face again 

(Step d) If a dormer is not fully textured, it is an indication that a conflict between image and face 

dimensions has occurred. Change over from Scale Mode “Relocate” to “Scale” or texture the affected 

complex interactively (cf. 8.1). 

 

8.4. Importing texture images with orientation parameters  

For the building and terrain texture usually aerial photographs or 
orthophotos are available. These must be imported together with their 
perspective orientation parameters and/or with their geo-reference 
into the data base. 

1. Open the menu CGModeler > Import/Edit Modeltextures. 
The Texture Images Window is opened.   
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2. Using the button  beside ImageFile an image file can be selected. The file name is suggested as texture 
name. 

3. If necessary change the name for the texture image, under which it will be stored and can be found in the 
data base (the texture name needs not be the same as the file name!) 

 

Note: In case the image name already exists in database, a new version of the image is created. 

Models referencing this image are automatically updated to the latest version of the image. 

Unchanged all roof textures will remain. To actualize the roof textures run the function for automatic 

roof texturing (cf. Manual CityGRID® Administrator) 

4. Choose the type of orientation parameters: Perspective for original central perspective photos or Ortho 
for corrected Ortho-images or maps. 

5. Either load a file with orientation parameters using the button  beside Orient.File (the supported file 
formats are customer specific) or open a window for manually providing these parameters by clicking at 

. Depending on the type of image the following parameters are contained: 

• For all types: Parameters of the exterior orientation: 

o Projection centre (x/y/z-coordinates) 

o Pose of the camera in space 

▪ 2 vectors: projection direction + up-vector of the image plane in space 

▪ angles omega/phi/kappa in ° (degrees) 

▪ angles alpha/zeta/kappa in ° (degrees) 

• For Orthophotos: pixel size in m 

• For perspective (aerial) images 

o Parameters of the interior orientation of the 
camera (from the calibration protocol): 
For scanned analogous images: 

▪ Focal length in mm 

o For directly digitally recorded photos: 

▪ Principal point of the camera  
(x/y-coordinates in the camera coordinate 
system in mm) 

▪ Principal point of the camera  
(x/y-coordinates in the camera coordinate 
system in pixel) 

o For scanned analogous images 

▪ Principal point of the camera  
(x/y-coordinates in the camera coordinate 
system in mm) 

▪ Affine transformation from camera 
coordinates to image coordinates:

 
o Estimated pixel size on ground (on the object): 

It should be estimated, in order to be able to 
provide the image of the image pyramid in the 
suitable resolutions. 

6. Using the button the texture image will be stored in the database/XML file. A copy of the image 
file is stored in the texture path of the database or in the sub-directory “images” of the XML file. Further 
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an image pyramid is generated (database only), so that the image can quickly be loaded in different 
resolutions. 

 

Note: If the geo-reference of orthophotos is available in Tiff World format (*.tfw for *.tif, *.jgw for *.jpg, etc), 

it will be interpreted automatically. 

Subsequently, the roof and/or the terrain can be textured with the texture image (cf. 6.4). 

8.5. Change orientation parameters for existing texture images  

1. Open the menu CGModeler > Import/Edit Modeltextures. 
The Texture Images Window is opened. 

2. Using the button DB beside ImageFile a window for 
selecting one of the texture images of the database is 
opened. 

3. Select a Texture Image and click at . 

4. The Texture Image is loaded together with its orientation 
parameters. In the Texture Images Window, besides 
ImageFile and Orient.File a hint is written that they come from the database.   

5. Click at  beside Orient.File and continue in Step 5 of section 8.4. 

8.6. Delete a texture image from the database  

1. Load a Texture Image: Steps 1 to 4 of section 8.5 

2. Click at for deleting it in the database. References to that image in Models (as roof texture 
image or as terrain texture image) are deleted (one can see that only after renewed loading the Model). 
However, the roof textures of Units, which were calculated from that image are not deleted. If you want 
these textures, too, please refer to section 8.9. 

8.7. Project lines onto model texture image  

In order to be able to examine the accuracy of the orientation 
parameters of the roof texture image and/or the accuracy of the 
roof lines, that part of the texture image that is valid for the Unit can 
be displayed together with the lines of the Active Complex 
projected onto this image: 

1. Check Textures in Display section of Main window for 
display of textures in Viewport (cf.2.4.2).  

2. Select the Active Complex (cf. 2.7). 

3. Click at Back Projection (cf. 5.4.3).  The roof 
texture image will be loaded, the relevant part of it is 
extracted and the roof lines will be projected onto this 
image. 

 

Note: Updating the roof texture can include several roof texture images and therefore texture large 

parts of an urban area at once. If several texture images are assigned to a model, the following 

rules should be kept in mind: 

• Perspective images are used prior to Orthophotos for calculating the roof texture. 

• If perspective aerial images are used, a 5% band will be removed to ensure that the 

fiducial marks are excluded from the texture. 
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• The image will be chosen, so that the parallax effect is minimal. (The Images will be sorted 

ascending by the angle between the element centre point beam to the projection centre 

of the picture and the extrusion direction of the elements). 

Optionally every assigned model image can be back projected by 
double clicking the desired image in Textures list in Model Properties 
window  

1. Open Model Properties window (cf. 2.8.1) 

2. In list Textures select an image and double click the entry to get the 
image loaded into material window together with back projection of 
the active complex. 

 

Advice: Use this method to check the appearance of the 

active complex in different model images, in case it’s 

known in which images the complex can be found. This 

can be necessary if the best suitable image has some 

visual obstacles (trees, tower crane etc.) included and an 

image without this objects must be found. 

8.8. Interactive texturizing from oriented 
images  

1. Load and Check out the Unit  (cf. 2.6.1). 

2. Check Textures in Display section of Main window for display of textures in Viewport (cf.2.4.2).  

3. Select the Active Complex, e. g. “roof” (cf. 2.7). 

4. Make face layer (e.g. roof) in the layer window to active layer. 

5. Activate polygon selection  (cf. 2.9.1) 

6. Select all faces in the preview window to be textured. 

 

Advice: In order to add faces to a selection, press when clicking the CTRL-button. In order to deselect 

faces, keep the ALT-button pressed. 

7. Click Load Material  (cf. 1.7.3) 

8. Choose Derive automatically from model as material source. 

9. Click . Subsequently, a selection of the oriented texture image will be 
created, which contains the whole object. This selection will be – according to the orientation parameters 
- saved as a texture image of the active element in the data source. The texture coordinates will be 
calculated for this image. The created texture will be immediately projected on the roof in the preview 
window. If necessary (if the orientation parameters have not been precise enough, or the geometry is not 
exact), projected triangles can be re-adjusted. 

10. Click Save Unit  (cf. 1.7.3) 

8.9. Delete textures of the active complex  

1. Load and Check out the Unit  (cf. 2.6.1). 

2. Check Textures in Display section of Main window for display of textures in Viewport (cf.2.4.2).  

3. Select the Active Complex (cf. 2.7). Depending on selected hierarchy level, the deletion of various 
complexes takes place. 
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Examples: If a unit is activated on unit-level, deletion of various textures of this unit is carried out. If the 

same unit is activated at the element-level “roof”, only all roof textures and textures of bound detail 

element complexes are deleted, but not the facade textures. 

4. Click at Delete all textures of the active complex  (cf. 1.7.3) 

5. Click Save Unit  (cf. 1.7.3) 
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9. Terrain Models  

The CityGRID® system is based on an existing terrain model, but is no efficient software for the production of terrain 
models. This should be done in advance using some terrain modelling software. The model can afterwards be 
converted into the standardized XML format supported by CityGRID® and imported into the data base (cf. Manual 
CityGRID® Administrator). 

When working with the Modeler only a TIN (triangulated irregular network) is used. Only for exporting in VRML (cf. 
10) in a Level of Detail (LoD) < 3 (Detail) an elevation grid is necessary. 

During the face generation usually the terrain model which is assigned to the active model is used. If no model is 
available, the "DEFAULT" terrain model is used. 

 

Note: After the setup of a database a terrain model with the name "DEFAULT" must be imported into the 

data base. 

9.1. Terrain Model editing  

CityGRID® Modeler is designed for building modelling. During these modelling tasks minor adoptions to the terrain 
model can become necessary in order to create high quality city models. For that purpose CityGRID® Modeler 
offers the possibility of terrain editing in a small scale. Performed changes can then be stored back to the data 
source. 

 

Note: CityGRID® Modeler is not a terrain modelling software and will never claim to be considered as one. 

Following described procedures and functions are meant for micro level terrain optimization and editing or 

for optimization of terrain models for visualizations in real time environments like CityGRID® Explorer. 

Terrain models are displayed in hierarchy window of the Modeler (cf. 2.7.1) as soon as Terrain display is activated 
in Modeler’s Main window (cf. 2.4.2) All visible DTMs in viewport are listed directly under the Model hierarchy entry 
in hierarchy window and are prepared for editing od display of specific information. 

Dependent on set display settings in Options menu (cf. 2.5) the complete terrain model can be seen or just a 
clipped part around loaded Units. I case of a clipped terrain model, “_sub” is added at the end of the terrain name 
for better indication. 

To activate a Terrain model select the corresponding entry in hierarchy window. As soon as a DTM has been 
activated the corresponding properties window comes up in the lower part of Modeler’s control section. Following 
information can be extracted from there: 

• TerrainKP: Unique database identifier of DTM (zero at XML files) 

• Faces: Count of currently loaded faces in viewport 

• Vertices: Count of currently loaded vertices in viewport 

• Name: Assigned terrain model name. On demand a new name can 

be specified and by cklicking  button be assigned. 

9.1.1. Interactive Terrain Model editing  

After activating a terrain model in hierarchy window it’s free for editing in case of an XML as data source. In case of 

a database stored DTM Check out  (cf. 2.6.2) must be done prior to any editing operation.  

For every terrain model all sub selection modes (vertex, segment, face, polygon, element) in layer window are valid 
and available (cf. 2.9) The only entry in layer window is Terrain, no other layer can be included and Terrain is locked 
for changes. By selecting appropriate sub selection modes (typically face or polygon) sections of the terrain model 
can be selected and edited individually by usage of 3D Studio standard operations, as well as by CityGRID® Modeler 
functions. 
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Note: If clipped terrain is set in Options menu no border vertices, segments with at least one border vertex 

as well as faces with at least on border vertex can be selected. Turn off clipped terrain to access geometry 

affected geometry. 

 
Example: Editing actions by usage of 3D studio functions 

• Selection of vertices, edges or faces 

• Delete vertices or faces by pressing Del- key 

• Moving of vertices using Select and Move …. 

On selections following CityGRID® Modeler functions can be applied: 

• Drawing Mode  (cf. 3.3.3): Use this function to draw new faces. By using Snapping  function 

precise drawing from existing vertices is guaranteed. Turn sub selection mode to Face  or 

Polygon  for direct draw of new geometry. Face sub selection mode allows drawing of single 
triangle faces, whereas Polygon mode allows creation of large areas in on drawing session. A drawn 
polygon is sub divided into triangle by 3D Studio automatically. 

 

Note: Mind drawing direction at creation of new faces. A drawn face will be visible at single 

sided display mode (default mode in CityGRID® Modeler, cf. 2.5) if the vertices of the face are 

digitized counter clockwise. 

• Coordinates-Tool  (cf. 3.3.1): Use this tool for unique setting of coordinate values to a 
selection, e. g. a unique height value. 

• Move Point to Face Tool  (cf. 3.4.5): A selection of vertices can be calculated in a 
previously defined plane. Use this tool to assign height values from a reference plane. 

 

Advice: Intersection plane “selected Element” and “selected Face” only influence vertices 

right underneath the selected Element or Face. All other selected vertices will remain at their 

position. To adjust these vertices switch to “User defined” mode. 

• Face Normals Tool  (cf. 3.4.8): By usage of this tool all faces or only selected faces of the 
terrain model can be flipped. This influences visibility in viewport in single sided display mode. (cf. 2.5) 

9.1.2. Optimize Terrain Models  

Depending on used terrain modelling software created TINs might have been put under an optimization routine to 
reduce triangle amount by keeping specified accuracy parameters. Not all terrain models must have passed this 
procedure, which leads to disproportional triangle count for representation of the earth surface. As a consequence 
such terrain models influences response time and therefore performance in software and can also cause massive 
problems in real time 3D visualizations. Total triangle count is still the limiting factor of available viewing systems. 

To offer relief the Terrain Optimization Tool  is available. Using 
built in 3D Studio technology this tool removes step by step vertices from 
terrain models and readjusts the face net. Mainly based on the face normals 
direction vertices are selected for elimination. The smaller aberration between 
neighbouring face normals is the more likely common points will be removed 
and affected faces recreated, leading to reduction of triangle count. 

To optimize terrain models do as follows: 

1. Activate terrain model in hierarchy window. 

2. Check out if necessary (cf. 2.6.2) 

3. Click Terrain Optimization Tool  (cf. 1.7.4) to start. 
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The tools properties window comes up in main bar of CityGRID® Modeler, offering a set of parameters to 
specify the optimization. Equipped with default optimization settings a first optimize is also performed on 
activated terrain model. Adjust available parameters to find best suitable optimization: 

• Optimization module:  

Defines used optimization method. Currently three different methods are available: Optimize, 
MultiRes and ProOptimize (3D Studio 2010 or higher). All functions are built in tools from 3D Studio 
Max for thinning out vertices and faces. Optimize forces an on the fly calculation of face distribution 
based on altered Optimization levels, whereas both other optimization modules pre calculate possible 
levels. 

• Optimization level:  

Rules intensity of optimization. Ranging from 0 (no optimization) to 100 (maximum optimization), with 
a default value of 25, this value approximately estimates how many points will be removed. E. g. an 
optimization level of 50 will remove some 50% of all loaded vertices, obeying the rule that 
neighbouring faces with similar oriented face normals will be favoured. Section Statistics in properties 
window compares not optimized with currently optimized terrain model and calculates corresponding 
vertex and face count. 

• Safe open edges:  

Judges if border points of loaded terrain model can be affected (unchecked) or not (checked) by 
optimization. Optimization module MultiRes can’t take advantage of this parameter. 

 

Advice: It’s strongly advised to activate” Safe open edges” at optimization of terrain tiles to 

keep accuracy of fit. 

• Calculate elevation difference:  

Calculates a height difference model from not optimized and optimized terrain models and derives 
statistical parameters from it for estimation of applied height changes. Maximum height difference, 
median and arithmetic mean are computed and displayed in section Elevation difference [m]. All 
values are derived by usage of non-negative values from difference model. 

 

Note: Depending on face and vertex count of terrain model, calculation of elevation difference 

can become highly time consuming! Use option therefore carefully as no interruption of once 

started calculation is possible. 

Any parameter change will directly affect terrain model and lead to recreation of terrain model in a 
preview. 

4. By clicking  previewed terrain model is accepted and replaced the 
original terrain model in viewport. 

5. Click at Triangulate/Apply changes  and Save  to take over changes (cf. 5.4.2). 

6. Check in terrain model eventually. 

 

Note: After terrain optimization an update of  façade extrusion might become necessary (cf. Fehler! 

Verweisquelle konnte nicht gefunden werden.) 

9.1.3. Clip, Cut out and integrate lines into Terrain Model  

Besides interactive editing and optimization of terrain models sometimes given structures must be integrated to 
readjust the face configuration, the whole DTM must be reshaped using a clipping polygon or sections inside the 
terrain model, following some closed polygons have to be removed. On demand given elevation values can be 
respected and the existing terrain model be adjusted to the given heights, or only the 2D information from the lines 

is taken for the called actions. All these tasks can be executed in Terrain Clipping Tool  (cf. 1.7.4) 

1. Activate terrain model in hierarchy window. 
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2. Check out if necessary (cf. 2.6.2) 

3.  Click Terrain Clipping Tool  (cf. 1.7.4) to start. 
The tools properties window comes up in main bar of CityGRID® Modeler. 
Define here to be used Lines and Layer as well as the applied working 
mode.  

• Cutting Layer: 

Displays which layer will be integrated into the terrain model. At start 
layer list is always empty und must be filled by user action in one of the three ways: 

o By clicking  a Unit in viewport can be selected and the Terrain Intersection Curve is 
automatically inserted into layer list. 

 
Advice: Regional selection  for loading of new Units (cf. 2.2.3) is also available during 

terrain modelling. 

o By clicking  every line in viewport can be selected. Valid are all Unit lines, 3D Studio 
created lines and via File Link Manager (3D Studio, cf. 3.6.2) linked lines. 

 

Advice: Use File Link Manager for Import of existing GIS line data that has to be integrated 

into a terrain model. Doing so vector areas can be created for colouring for visualizations. 

o Drawing mode offers possibility for free hand drawing in viewport. Every drawn line is 
automatically added to the layers list. Press button to start drawing mode. First click in viewport 
starts a new sketch, a right click ends the sketch. Second right click ends drawing mode and 
returns to Terrain Clipping tool. 

 

Note: CityGRID® doesn’t support tangential curves (Bezier curves). Found tangential curves 

are automatically straightened based on existing vertices. Any curved representation in 

viewport is without effect!  

Click  to remove Layers from Cutting Lines list. 

• Working Mode: 

Rules how lines are integrated into the terrain model. Every mode can use existing 2D or 3D 
information from cutting lines. The 3D mode is indicated by “with elevation” extension in selected 
Working mode. 

o Integrate: 

Adjusts the face configuration of terrain models by given lines. Existing Faces are cut and the 
lines are so included into the terrain model. Dimensions of the terrain model remain unchanged. 

 

Advice: This mode can be used for interactive integration of break edges (with elevation) 

as well as for calculation of GIS data into the DTM. 

o Cut out: 

Given lines are integrated into the terrain model and face configuration is modified. For closed 
polygons the interior area is removed from the terrain model to form holes. All open polylines 
have the same effect like Integrate mode. 

 

Advice: Use this mode to cut holes into your terrain model. 

o Clip: 

Given lines are integrated into the terrain model and face configuration is modified. For closed 
polygons the exterior area is removed from the terrain model. All open polylines have the same 
effect like Integrate mode. 
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Advice: Clip is typically used to reshape terrain models on a given boundary. 

4. By clicking  Lines in Cutting Lines list are integrated into the terrain 
model. The layer list is emptied and the tool is ready for next calculation process. 

5. Click at Triangulate/Apply changes  and Save  to take over changes (cf. 5.4.2). 

6. Click Terrain Clipping Tool  (cf. 1.7.4) to end. 

7. Check in  terrain model eventually. 

9.2. Merge Multiple Terrain Models to a single Terrain Model  

1. Open the menu CGModeler > Edit Terrain 

2. Select Create new Terrain in the assistant and click at Next 

3. Select a name for the terrain to be created. 

4. Choose any number of existing terrains to be merged. 

5. Click at Start. A new terrain model will be created and stored in the database. 

9.3. Expand a Terrain Model by existing Terrain Model(s)  

1. Open the menu CGModeler > Edit Terrain. 

2. Select Expand an Existing Terrain in the assistant and click at Next. 

3. Choose the terrain to be expanded (“Base Terrain“)  

4. Choose any number of existing terrains.  

5. Click at Start. The selected terrain models are added to the base model which is stored in the database 
afterwards.  

9.3.1. Derive ElevationGrid  

The elevation grid of a terrain model is usually not necessary. Only for exporting in VRML (cf. 10) in a Level of Detail 
(LoD) < 3 (Detail) an elevation grid is necessary. 

1. Open the menu CGModeler > Edit Terrain. 

2. Select Derive ElevationGrid in the assistant and click at Next. 

3. Select the grid width in both coordinate directions. 

4. Choose the terrain model to be updated. 

5. Click at Start. The elevation grid will be derived and stored together with the terrain model. 

 

Merge, expand and convert to Elevation Grid is available only for the database version of the Modeler. 
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10. Export of Data 

The following export formats are supported. For some of them not all meta data are stored. Only the export to the 
open XML format defined by UVM Systems stores all information, so that this format can be used for a complete 
data transfer. 

Format Geometry Texture Unit/Object/Element 
hierarchy + meta data  

xml    
gml    
VRML    
kml    
DWG/DXF    

As CityGRID® is a Plug-in in Autodesk 3D Studio Max, the scene can additionally be saved as max-file (with 
geometry and texture) or the export supported by Autodesk can be used. 

 

Note: Keep in mind that default save and export functions of Autodesk 3D Studio Max disregard the 

coordinate offset values of CityGRID® Modeler. We strongly recommend entering theses values in file name, 

to preserve the possibility of a combination with non coordinate-reduced data. 

10.1. Exporting XML, DWG/DXF, CityGML and VRML 

10.1.1. General export settings 

The active Unit, an area (the loaded part of the Working Set), or a Model can be exported. 

1. Define a Working Set (cf. 2.1)  

2. Load the part/Unit to be exported  (cf. 2.2) 

3. Click at Export  (cf. 1.7.1).  

Select the path, file name and file format in the file browser. 

4. The Export Settings Window is opened in which the following 
parameters are given: 

• Only active Unit: 

exports the Unit currently selected in hierarchy window 

• all loaded Units: 

writes all the data that is currently in viewport of the Modeler to 
the export format. This also applies in particular to the clipped 
terrain, if in the export settings the corresponding option is set. In order to export the entire terrain 
model, deactivate the checkbox in the options menu of the modeler. (cf. 2.5) 

• whole model: 

exports all the data in the model, regardless of how much of it was loaded. 

 

Note: The options only active unit and all loaded Units are only available if a Unit is active 

in hierarchy window. 

5. You can now set further export parameters in the format-specific export settings window 

• LoD:  

Specifies the generalization of the buildings to be exported. DETAIL (LoD 3) is the highest possible 
level, BLOCK (LoD 1) represents the lowest. (see Manual CityGRID® Basics)  
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• Historic version:  

Specifies whether the export is to be performed for historic versions. If this option is selected then 
data corresponding to the specified time is exported from the database irrespective of whether the 
version corresponding to the specified export date is the most recent version or not. 

• Prefix Texture Files:  

Sets the input string before the texture name of the exported texture images. If no value is specified, 
images will receive the images names allocated by the database. 

 

Note: The use of the prefix is necessary when using multiple databases, if exports are to be 

merged from these databases in another database (e. g. CityDB).  

• Bounding Box:  

Optionally define a rectangular export region by specifying minimum/maximum X and Y values in the 
defined coordinate system of the data. Units partially covered by this bounding box will be exported 
too. 

• Export data:  

o For Units just the primary data (lines), or also derived faces, eventually together with textures 
may be exported. Depending on the selected export format and the supported data types, the 
offered export options may differ. 

o Terrain faces, eventually with texture, may be exported too. 

• General settings: 

o The texture resolution (in mm at the object) can be defined. 

o For DXF, in general different layers are generated for the different types of lines, e.g. all ridge lines 
of all Units are written to the same ridge layer. If Unit → Layer is selected, for each Unit a layer is 
created, in which all lines of the Unit (of any type) are written. 

o Remove coplanar Faces eliminates all congruent faces within a Unit. By doing so buildings with 
one large interior room are exported, regardless of the assembling of CityGRID® complexes. 

o Join Polygons controls up to which canting adjacent polygons can be seen as planar and 
therefore be exported as a single surface. Tolerance indicates the distance of adjacent surface 
normal with length of one meter (unit vector) in meters. For small angle values it corresponds 
with the angle between the surface normal in radian measure. 

 
Example: A value of 0,01 corresponds with an aberration of 1cm of a one-meter long 

surface normal and respectively an angel of 0,01 π. Converted to degree the value 

would be 1,8°. 

• Coordinates Reduction:  

o Origin of the local coordinate system defines the zero-point of the used coordinate system for 
export. If the checkbox is activated, the input coordinate system is used, otherwise it will be 
replaced by the local coordinate system. 

 

Tip: By using these parameters VRML-files in particular can be transformed into a local 

coordinate system at the export, so that commercially available viewers can display them 

without any difficulties. VRMLs with country coordinates often have difficulty displaying 

regional coordinates because of the digit length. 

If using an alternative coordinate origin, it is recommended to add the offset value to the 

file name. 

6. Click  to start the process. 

 

Note 1: When exporting texture a subfolder with the name „images“ is created in the directory of the export 

file, into which the texture images are exported. If this directory existed already, texture images are exported 

into the existing directory. The export file and this subfolder belong together! If the export file is copied/moved 



 

 Manual CityGRID® Modeler – Page 108 

  

CityGRID  
         MODELER 

to another place, also the folder "images" must copied/moved with it, otherwise the textures won’t be 

available any longer. 

 

Note 2: If a terrain model is exported into VRML in a Level of Detail (LoD) smaller than 3, an elevation grid is 

needed. See section 6.15.3 for generating it. 

 

Notes: You can only export historic states at model level. If you have checked the corresponding checkbox, 

only historic versions are exported at the specified time. All working versions are not considered, even if they 

are valid at the specified time. 

10.1.2. Advanced CityGML export settings  

As an interchange format for city model data CityGML offers over VRML and DXF a set of individual specifications 
during export. Parameters such as CityGML version, attribute integration to semantic transformations in the 
buildings to be exported can be defined in its own settings window. 
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In the export window for CityGML the button  is available to open the window for the export 
parameters. 

With each CityGRID® installation a standard set of parameters is supplied, named DEFAULT. Changes to the 
default parameter set are not possible. Changes at the default export parameters must be saved to a new 
parameter set when you exit the window. In addition to the default set of parameters an arbitrary number of 
additional export settings can be stored. 

 

 

Note: All parameter sets are stored in the file citygmlexport.ini in the log directory of CityGRID®. Please provide 

this file to UVM Systems when you need support with CityGML export.  

• Active Parameter Set:  

Invokes the saved export settings. After initial installation, only the default parameter set is available. 

• CityGML Version:  

Defines which version of CityGML standards shall be written. 

• Reference System:  

specifies the information about the underlying coordinate system of the dataset 

o Use EPSG Code from Data:  

accesses the stored EPSG code from model (cf. manual CityGRID® Administrator). If no EPSG 
code was assigned srsName “unknown" will be written to CityGML file. 

o Use srsName:  

Provides the ability to specify an EPSG code directly. Set EPSG codes at model are ignored 
thereby. The allowable spellings are listed in the dropdown list. The "#" characters are to be 
replaced by the user. 

• Export Data: 

regulates which geometry objects are written at export. 

o Thematic Surfaces: 

creates thematic surfaces of the CityGRID® elements for each building. (Roof to RoofSurface, 
facade to Wall Surface etc.) 

o Solid: 

combines all CityGRID® Elements of one building to one Solid. 

o Outer Building Installations: 

exports CityGRID® Detail Element Complexes. 

o Terrain Intersection Curves: 

writes the intersection curve of the buildings. 

 

Note: To see the building data in CityGML export, either Thematic Surface or Solid has to be checked. 

• Miscellaneous: 

groups parameters not assigned to groups explicitly. 

o cityObjectGroup for CityGRID Model: 

generates an independent CityObject group for every exported CityGRID® Model 

o gml:location for CityGRID Units: 

writes a representative insert point of the Unit in CityGML file. 

o Write CityGRIDs Generic Attributes: 

exports all existing attributes from CityGRID® data set. 
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Note: Attributes for Models, Units, Objects, Element Complexes and Elements can be managed by 

CityGRID® 

• Automatically generated Attributes  

offers the possibility of certain attributes of the geometry data to be deduced. The attributes are added to 
the specified complexes. All calculated values, with the exception of basic level (NN) are given in relative 
height of the building. The attribute name can be defined by the user. Attributes that do not appear useful 
for certain complexes are grayed out by default. 

o Creation Date: 

writes the current date when exporting to the CityGML file. 

 

Note: Creation date therefore relates to the creation time of the GML file and not the generation 

of the model itself. 

o LoD1 Height: 

calculates the mean of the highest and lowest point of the eave polygon. 

o LoD2 Eave Height: 

is the lowest point of the eave polygon. 

 

Note: If the parameter "Roof overhangs according to German SIG3D ("AG Quality”) 

Recommendations” is set the lowest point of the upper facade polygon is used. 

o LoD2 Ridge Height: 

delivers the highest building point as an attribute value 

o LoD2 Roof Area 3D: 

delivers for each building or each Building Part the sum of the individual roof areas in square 
meters. 

 

Note: The calculation uses each LoD2 area. Thus, an area is included under roof details when 

the surface form was not adjusted accordingly in CityGRID® (extrusion type "Extrude to parent 

with holes", or on the penetration analysis, see manual CityGRID® Modeler) 

o Ground area 2D: 

indicates the constructed area of the building in square meters. If floor polygons are present, the 
area is calculated. Otherwise, the upper edge of the facade polygon serves as a reference. 
Possibly present courtyards are included in the calculation. If no upper facade line is available, 
any upward facing surface is used. 

o Ground Elevation: 

is the lowest point of the building at sea level (based on the used coordinate system). 

o Steepness: 

defines the slope angle for every polygon. This parameter is only useful at Roof Surfaces. 

o Exposition: 

indicates rotation of areas towards north direction. Positive values rotate from north through east 
to south, negative over west. Horizontal surfaces doesn’t have set exposition values. 

o Angle Units: 

determines whether Steepness and Exposition are given in degrees (0-360) or grads (0-400)  

 

Advice: If generic attributes also have angle values, it is advisable to choose the same 

angle units for the automatically generated attributes. 

• Texture Themes 

allows to determine which topics are written to the CityGML file. (cf. manual CityGRID® Administrator) 

o Type 
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offers a choice between the standard color, standard texture and any other texture themes. 
Standard colors are the set CityGRID® surface colors (see Manual CityGRID® Modeler), standard 
texture all previously applied textures and Named Theme is a user defined texture theme (e.g. 
solar potential) 

 

Note: At option standard texture standard colors will be used, for untextured areas. 

 

Note: Named Texture Themes are currently not supported by CityGRID®. 

o Theme Name  

specifies the texture theme that was given during automatic texturing. (cf. manual CityGRID® 
Administrator) 

Data Preparation  

offers the possibility models to influence geometry or semantics of the building, before they pass through 
the CityGML Export. 

 

Note: Each option of data preprocessing modifies the geometry of the building during the export 

process, which on the one hand leads to the result being (significantly) different from the CityGRID® 

dataset and on the other hand increasing the susceptibility to geometrical errors that can arise from 

fully automatic processing. The options should therefore be activated only when needed. 

• Roof overhangs 

o Unchanged 

leaves the roof overhang analogous to the situation in CityGRID®. The roof areas remain 
geometrically identical to the original data set (possibly grouped together as coplanar polygons, 
if the corresponding general export option has been set, see 10.1.1). The roof overhang element 
of the CityGRID® dataset, however, remains unconsidered because there is no equivalent in the 
CityGML data model. 

o according to German SIG ("AG Qualität"): 

Recommendations modifies existing roof overhangs such that they are becoming independent 
BuildingParts. CityGRID® roof overhang elements are dissolved and areas facing towards ground 
are. Building roof is trimmed to intersection of upper facade polygon and roof faces. The roof 
overhang fits directly to the so-formed roof element, but forms an independent structure. 

 
Roof with roof overhang              Roof overhang             Roof Surface 

 

o Removed 

Modifies existing roof surfaces such that only those parts of the roof are preserved, which can lie 
within the facade polygons. Roof surfaces and façade surfaces are flush with each other. 

• Integrate LoD2 BuildingInstallations into Building/BuildingPart: 
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checks all Detail Element Complexes for their set LoD. At LoD2 CityGRID® roof details are converted to 
individual CityGML Building Parts and crops roof faces underneath the roof details and modifies building 
semantics accordingly. Thus in CityGML former roof details will appear as part of the main roof. 

• Create missing GroundSurface-Elements:  

CityGRID® complexes typically have no floor surface when the facades are extruded to the terrain model. 
But if floor surfaces (Ground Surfaces) are desired they can be generated during export via this parameter. 

• Generate ClosureSurface Elements: 

In coplanar surfaces CityGML provides the opportunity to introduce so-called closure surfaces. The 
coplanar surfaces are dissolved out of the thematic surfaces and stored as separate objects. If necessary, 
they can be displayed or deliberately omitted. By Closure Surfaces internal surfaces can identified and 
building with maximum interior room can be produced. 

If parameters are changed, al modifications must be stored to active parameter set (button Save) or a new 
parameter set has to be created (button Save As). During export the most recent parameter set is used. It does not 
matter whether you exported from CityGRID® Administrator or Modeler. 

10.2. Advanced KMZ export settings 

In KMZ export window the button  is available to open the window for the export parameters. 
The height reference, as well as the underlying coordinate system of the dataset can be defined therein. 

1. Run steps 1 to 5 from section 10.1 

2. Open Advanced settings 

 
• Height Reference: 

defines placement of Units on Google Earth terrain model. 

o Relative Z-Coordinates:  

Places the units via a central insertion point at the Google Earth terrain model. This will ensure 
that the building does not float above the ground. However, the height accuracy can‘t be 
guaranteed then. 

o Absolute Z-Coordinates:  

Uses the existing height values of the Unit in order to convert it into the coordinate system of 
Google Earth. Thus, the buildings retain their actual 3D position and altitude accuracy. If the 
generalized terrain model from Google Earth deviates too much from the used CityGRID® model, 
there is a risk that units float, or plunge into the terrain. 
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• Coordinate System of Data  

determines which coordinate system is used for translation into geographic coordinate system of Google 
Earth  

o Use Reference System from Data:  

Uses the information of the coordinate system of the model (c.f. Fehler! Verweisquelle konnte n
icht gefunden werden.). If a model coordinate system not set, this method can’t be applied. 

o Use:  

provides a list of currently implemented coordinate systems, from which a suitable system 
should be chosen. 

o EPSG Code:  

Allows you to enter a valid EPSG code (http://www.epsg-registry.org/) to define the coordinate 
system. As input only, the code number is expected. 

o WKT File:  

Provides the ability to make a coordinate system via a Well Known Text (WKT) file available. The 
structure of the WKT file can be obtained by selecting a predefined coordinate system (see Use).  

 

Note: With the WKT file you can define any coordinate system, regardless of whether there is a valid 

EPSG code or not. In particular, local offset values can be considered this way. 

 

 

Note: Buildings are placed in Google earth based on their bounding box. From this box one point is selected 

and calculated on the ground. If you alter the height of the Google Earth Terrain by adjusting the height 

multiplication, the buildings position will be readjusted automatically, based on the selected point. As a 

consequence of this some buildings might lie partially under the terrain or fly over it depending how strong 

and inhomogeneous the terrain changed around the reference point. 

3. Press  to start the process. 

 

Note: You can only export historic states at model level. If you have checked the corresponding checkbox, 

only historic versions are exported at the specified time. All working versions remain unconsidered, even 

if they are valid at the specified time. 

 

Note: During the export, a kml file and a folder named "link" are created under the specified filename to 

which every exported Unit is saved as a kmz file. If several Google Earth exports are written to the same 

destination folder, a separate kml file is created for each export, but the "link" folder is used as the common 

save folder. 

 

 

http://www.epsg-registry.org/
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11. Error Reporting 

The CityGRID® software is developed, tested and used internally by UVM Systems, and strive for an error-free 
product. Nevertheless we cannot guarantee that errors will not occur while your work with it. 

The data base concept and the version management however ensure that data cannot be lost. Should, due to 
software error, the edited version become corrupt, there is always the last stable version stored, in which nothing 
has changed. In important cases corrupt versions can usually still be repaired if the error is found.  

Through experience we are aware that the following errors may occur: 

1. Autodesk 3D Studio Max crashes without prior warning/message: The reasons for such fatal errors are 
usually problems of 3DS itself and are beyond our control. 

2. If you get a CityGRID® Error messages it is typically because of corrupt data. Usually, continuing to work 
is possible. 

3. Script-Errors: The reasons for these are often mistakes in operating with the software. In most cases 
continuing working is possible. If further problems occur, we recommend exiting the Plug-in CityGRID® 
and starting it again. 

If you want to send an error report, please enclose the following information/data: 

1. Verbal description of the actions which produced the error 

Log file: You can find the protocol in your profile under: \Application Data\CityGRID\CityGRID.log or. 
Administrator.log. Find the log files also in the specified place if you’ve set the Log Path in Settings menu 
of CityGRID® Administrator  

 

Note: Please backup this file immediately after a crash, because the renewed starting of the software may 

cause the file to be overwritten. 

 

Advice: In Modeler, the directory of the log file can be opened using the menu „CGModeler – Logging”. 

For bugs in Modeler: 

1. Export the data to xml (cf. 10) 

2. Export the data to “CityGRID ASC Scene Export“ (analogously to xml-Export) 

If the bug can be reproduced in the Modeler, we ask you for the additional information: 

1. Re create all actions to the point before the error occurs 

2. Switch on Use Comprehensive Logging via the menu CGModeler – Logging (note: this slows down the 
software significantly)  

3. Execute the action which produced the error. 

4. Save the log file (cf. step 2 above) 

5. Switch off again the comprehensive logging command 

Please send error reports to support@uvmsystems.com 

mailto:support@uvmsystems.com
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12. Contact 

 

 

 

 
 

UVM Systems GmbH  

www.citygrid.at 

www.uvmsystems.com 

 

 

 

http://www.citygrid.at/
http://www.uvmsystems.com/

